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1 Introduction
The BlueLite X1 is a Universal Show Control System for USITT DMX-512 based lighting fixtures and
effects. Since a rudimentary DMX-512 console can be used to control even a very complicated DMX512 fixture, this may sound a bit pretentious; however, the X1 is not just a computerized lighting board.
The X1 does use many concepts that lighting board operators are already familiar with. However, the X1
also includes a number of features that allow it to easily perform tasks that would be extremely difficult,
if not impossible, on a conventional lighting console.
Understanding these features is essential to getting the most from the X1. So, the following is a brief
explanation of some terms and concepts that you should know before using the X1.

1.1 Terms and Concepts You Should Know
Devices
On the X1, you do not directly access DMX-512 channels. Instead, you create named Devices that use
the X1’s 8192 channels (2048 on each X1 interface, 512 on each X1-Mini) of DMX-512. Rather than
having to memorize that Mac 2000 #7 uses channels 49 to 79 on universe 2, you create a Device that
occupies those channels and name it “Mac2000 7”, or “M2K U2 49-79” if you like the job security that
comes with making things difficult and cryptic.
Devices are then referred to by name when editing Cues, etc. One advantage to this approach is that you
can later move a Device to a different set of DMX-512 channels without losing any Cues you have
already created for it.
Templates
Devices are created using Templates. Templates serve two very important purposes. First, Templates
control how a Device looks in the X1 Cue Editor. For example, instead of remembering that channel 3 on
a particular fixture must be set to 155 for green, you can pick ‘Green’ directly from a combo box.
Second, Templates tell the X1 how the Device should respond to cross fading, Grand Master input, and so
on. On complex fixtures, it is very common for multiple features to be combined on a single DMX-512
channel and/or for values on one channel to alter the behavior of others. This means that crossfades
between settings on a conventional lighting board often yield unexpected results onstage from complex
fixtures. Templates allow the X1 to fade from ‘forward color spin’ to ‘reverse color chop’ seamlessly,
comparable to a fixture manufacturer’s own dedicated, fixture-aware controller.
Although the X1 comes with a collection of pre-made Templates for popular fixtures, it also has a built in
Template Editor so that you can create your own. You can also share Templates with other X1 users at
www.innovateshowcontrols.com.
Cue
Like many show control systems a Cue on the X1 is, at its core, a collection of DMX-512 level settings.
One important difference is that unlike many lighting consoles a X1 Cue does not automatically include
level settings for all 8192 available channels. A X1 Cue only affects Devices that have specifically been
added to it. Devices, in turn, only affect DMX-512 channels to which they have been assigned.
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This gives the operator great flexibility. A Cue can be a complete stage look (all fixtures, effects, etc.) or
just a subset of the available Devices (laser Cues, special effect Cues, etc.)
Submaster
On the X1, a Submaster is a fader (slider) on the Main or ‘Console’ window to which a Cue can be
assigned. The X1 has 24 Submasters, which can be controlled using the mouse, keyboard, or an external
DMX-512 console.
Preset
On the X1, the term Preset has a very specific meaning. An X1 Preset is a collection of Cue assignments
for all 24 of the X1’s Submasters. Since the X1 has 24 presets, each of which can remap all 24
Submasters, operators have potentially very rapid access to 576 Cues for manually operated shows. For
those of you who have yet to memorize your full 9 digit zip code, a more practical approach might be to
keep 12 or 16 Submasters ‘fixed’ with basic Cues and use the X1’s presets to remap the remaining
Submasters with special effects, etc. for different portions of a show.
XY Crossfaders
At their core the X1 XY Crossfaders are just additional Submasters. The major difference is that they are
generally intended to be used as a pair. The Y fader is ‘upside down’ with respect to the X fader and both
faders are interconnected so that they can easily be moved simultaneously. The purpose, of course, is for
easy crossfading (transitioning) between Cues.
The X1 has four pairs of XY Crossfaders, one for each available Event List (described later this in this
section). However, only one XY pair is displayed on the Main or ‘Console’ window at a time. All four
pairs can be used manually, but are primarily intended for pre-programmed show playback.
Event List
On the X1, preprogrammed shows consist of a series of Events. An Event is a time (hours, minutes,
seconds, frames [1/30th of a second]), a Cue number, a fade out time, a fade in time (if different) for the
previous Cue, and an optional comment.
A collection of events is called an Event List and can be played back in several ways; in response to an
internal clock, in response to external SMPTE timecode, or manually single stepping. The X1 has four
available Event Lists and each can be played concurrently using its own XY Crossfader pair. This allows
different aspects of a show (lasers, moving fixtures, conventional lights, and special effects) to be preprogrammed separately without having to be concerned about overlapping event times or cross fades.

1.2 How to Use the Rest of This Manual
Assuming that you have not already thrown the X1 Installation CD into your computer, run setup,
attached the X1 controller hardware via USB, and plugged a DMX-512 cable into everything that even
remotely resembles a 5 pin XLR on the back, you may wish to read Chapters 2 and 3 which discuss:
•
•

Installation
X1 Hardware Hookup
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Chapter 4 is a Quick Start Tutorial. Although it does not cover every available trick and feature, it does
highlight most major features.
The subsequent chapters are each dedicated to a major window in the X1 software. Users wishing to
master more advanced features and shortcuts can skim these or refer to them as needed. Show
programmers and operators who are having difficulty sleeping because they have consumed way too
many caffeinated beverages at rehearsal may find therapeutic value in a more careful review.
Finally, Chapter 13 is a Template Creation Tutorial. This walks you through the creation of a more
sophisticated Template.
Throughout this manual there are tricks and tips intended to help you work more effectively with the X1.
These always appear in the following format:

If the high voltage probe on your meter is mysteriously standing upright and quivering, avoid contact with
any nearby metal surfaces.

1.3 Obtaining Additional Support
At Innovate Show Controls we take customer satisfaction very seriously. We realize that our products are
often operated in high stress, sleep deprivation situations. We want our products to solve some of our
customers’ headaches, not add to them.
If you are having difficulty with your X1 and cannot find the answers you need in this manual or in the
X1 application’s online help, there are several additional options available to you.
•

www.innovateshowcontrols.com is a good place to start. This online resource contains the latest
software, long with the latest tips, templates, and information.

•

There is also an Online BBS Forum where you can post questions for other Users and the
Innovate Show Controls staff.

•

X1 specific support can also be obtained via email by writing to
support@innovateshowcontrols.com

•

Finally, you can call us by phone. See the ‘Contact’ page on www.innovateshowcontrols.com for
the telephone support number nearest you.
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2 Installation
Installing the BlueLite X1 consists of two basic steps, installing the application software and installing the
controller hardware and device drivers. Although these steps can be performed in either order, it is
recommended that you install the application software first.

2.1 Before You Start…
However, before you start, please make sure that the computer you are installing the X1 on meets all of
the following criteria:
•

Running Windows 2000 or Windows XP (Home or Professional) as an operating system (OS)

•

You must have Administrative rights on the computer (rights to install drivers, etc.)

•

At least 256 megabytes of physical memory installed

•

A Pentium CPU with a speed of at least 350 MHz or higher (800 MHz or higher recommended)

•

A graphics adapter with at least 32 megabytes of video memory (at least 64 megabytes
recommended) and which is DirectX 8.1 (or better) compatible (AGP or other high performance
graphics bus recommended)

•

Video mode should be True Color (16 or 32 bit) and 800x600 or higher (at least 1024x768
recommended)

•

At least 24 megabytes of free hard disk space

While the X1 setup program tries to test for some of these requirements, there is still plenty of room for a
determined user to get into trouble. Do yourself a favor and use the X1 on a relatively new and capable
Windows PC. You probably can get the X1 hardware to install on that ancient Windows 98 machine in
your closet. You know, the one that makes a wheezing and thumping sound like the Professor’s bicyclepowered inventions on Gilligan’s Island, but take our word for it, you will not be happy with the results.

2.2 Application Software Setup
Just in case you have led a sheltered life and have never installed an application on a Windows PC…
Step 1: Turn on the PC and log in.
Step 2: Insert the BlueLite X1 Installation Disk into your CD ROM drive.
Step 3: If the installation program does not automatically start, run “X1Install.exe” on the root (base
directory) of the CD.

Follow the prompts to install the application on your PC. If necessary, you will also be prompted to
install Microsoft’s DirectX.
You can always download the latest version of the X1 software from www.innovateshowcontrols.com.
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2.3 Hardware and Device Driver Setup
Although it is not called ‘plug and pray’ for nothing, X1 hardware installation is generally straight
forward.
Step 1: Connect the X1 Controller to AC power (100-240 VAC, 50-60 Hz).
Step 2: Turn on the power switch, located on the front left corner of the X1 Controller.

Step 3: Turn on the PC and log in. Make sure your account has administrative rights
(permission to install device drivers).
Step 4: Connect the X1 Controller to your PC using the provided USB cable.

Important Note: For the X1-Mini, skip steps 1 and 2.

2.3.1 Windows 2000 Driver Installation
If your computer is running Windows 2000 within a few moments a dialog box similar to this should
appear:
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Step 5 (for Windows 2000): Select ‘Next’.

Within moments you should see a dialog similar to this one:

Step 6 (for Windows 2000): Make sure that “Search for a suitable driver for my device” is selected then
click on ‘Next’.

A dialog similar to the following dialog should appear:
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Step 7 (for Windows 2000): Place the BlueLite X1 Installation CD in the PC’s CD ROM drive. Make
sure “CD-ROM drives” is selected as a search location then click on ‘Next’.

Selecting ‘Next’ or ‘Yes’ on any remaining dialogs should properly install the X1 Device Drivers on the
PC. When the drivers are properly installed and active, the blue indicator light on the front right side of
your X1 Controller should glow very dimly.

When there is difficulty installing a device, Windows will often install a ‘dummy’ driver for the peripheral.
Users are then confused when repeating the manufacturer’s installation instructions does not result in the expected
‘New Hardware Found’ dialog. To remove one of these dummy drivers, you should access the Windows Device
Manager (right click on ‘My Computer’, select ‘Manage’, and then ‘Devices’). Locate the dummy device (usually
under USB devices with an exclamation mark (!) next to it). Right click on it and select ‘Uninstall…’

Some versions of Windows may demand a device installation disk when a USB peripheral is moved to a
different USB connector on the same PC. You can copy the “Drivers” folder from the X1 Installation Disk to your hard
drive, and then ‘Browse’ to this folder if asked for the X1 Installation Disk in the future.

2.3.2 Windows XP Driver Installation
If your computer is running Windows XP, the installation screens are slightly different from Windows
2000. Within a few moments a dialog box similar to this should appear:
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Step 5 (for Windows XP): Make sure that “Install from a list of specific location (Advanced)” is selected.
Click on ‘Next’.

Within moments you should see a dialog similar to this one:

Step 6 (for Windows XP): Make sure that “Search for the best driver in these locations” is selected.
Step 7 (for Windows XP): Place the BlueLite X1 Installation CD in the PC’s CD ROM drive. Make sure
“Search removable media” is selected as a search location then click on ‘Next’.

2-5

Step 8 (for Windows XP): Select ‘Continue Anyway’.

Important Note: Like Windows 2000, XP warns that the X1 Device Driver is not Microsoft Certified. But
the XP warning is much more dire. Presumably Microsoft is either looking out for you, or just trying to
pressure companies into using the costly Microsoft Driver Certification Program. Whatever the motive, it
is safe to click "Continue Anyway".
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Step 9 (for Windows XP): Select ‘Finish’. As with the Installation for Windows 2000, when the drivers

are properly installed and active, the blue indicator light on the front right side of the X1 Controller
should glow very dimly.

When there is difficulty installing a device, Windows will often install a ‘dummy’ driver for the peripheral.
Users are then confused when repeating the manufacturer’s installation instructions does not result in the expected
‘New Hardware Found’ dialog. To remove one of these dummy drivers, you should access the Windows Device
Manager (right click on ‘My Computer’, select ‘Manage’, and then ‘Devices’). Locate the dummy device (usually
under USB devices with an exclamation mark (!) next to it). Right click on it and select ‘Uninstall…’

Some versions of Windows may demand a device installation disk when a USB peripheral is moved to a
different USB connector on the same PC. You can copy the “Drivers” folder from the X1 Installation Disk to your hard
drive, and then ‘Browse’ to this folder if asked for the X1 Installation Disk in the future.
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3 X1 Hardware Hookup
Since the X1 is a show control system, it is reasonable to assume that having gone to the trouble to install
the X1 hardware and software, most users will want to connect other equipment to it. This chapter covers
the various connections and controls on the X1 Controller.

3.1 Front Panel

Actually, the word ‘controls’ above is a bit of an exaggeration. The X1 Controller’s front panel contains
the only user control; an on-off switch. Needless to say, unless you possess supernatural powers, it must
be on (white dot depressed) for normal operation.

The X1-Mini has no on-off switch, so do not waste time looking for it!
The front panel also has a single blue indicator light. Although system status is generally monitored
using the X1 application software, the indicator light does report certain status information directly.
Indicator Light
¼ Brightness
½ Brightness
¾ Brightness
Full Brightness
Blinking ½ Brightness to Full Brightness

Meaning
Proper USB connection with PC and required device
drivers established
Communication with Application is established
Waiting for external SMPTE sync
Application is in Play mode
Application is in Record mode

3.2 Rear Panel

In the interest of wiring sanity, all connections to the X1 Controller are made at the rear of the box.
Examining the rear panel from left to right, you find the following:
4 DMX-512 Outputs (1 on X1-Mini)
Each of these four, 5-pin XLR style connectors is a unique USITT DMX-512 universe. Although fullcurrent RS-485 line drivers are used for each output, normal DMX-512 cabling and termination issues,
unfortunately, still apply.
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If you are new to the ‘joys’ of DMX-512 cabling and connection reliability you might want to check out the
following online articles:
www.lighting-association.com/links/dmx-faq.htm
www.etdimming.com/dmxtour.asp
www.euro-pa.be/dmx.html

DMX-512 Input
This is a standard USITT DMX-512 input. Users can select a 24 to 47 channel block from this input to
control the X1’s 24 Submasters, XY Crossfaders, Grand Master, Presets, and Event Lists. The block can
be located anywhere in the 512 channel universe.
Important Note: This input is ‘terminated’ (load resistor).
DMX-512 Thru
This USITT DMX-512 output mimics whatever DMX-512 signal is present on the X1’s DMX-512 Input.
This connector is not present on the X1-Mini.
Important Note: This is an active thru connection. In other words, the Thru connector is not simply
wired in parallel with the input connector. The X1’s Thru connector has its own full-current RS-485 line
driver, which is driven by the electrically decoded input signal.
This extends the cable lengths and increases the number of DMX-512 fixtures that can be reliably
connected ‘downstream’ of the X1 Controller. But, it also means that terminating a DMX-512 connection
on the X1’s Thru connector will not terminate the X1’s DMX-512 input connection.
Sync In
This is the X1’s very forgiving mono input for external SMPTE timecode. It will accept most line and
headset level unbalanced audio signals and can also be driven from the ‘TTL level’ output on older sync
generators.
Although 30 fps non-drop (black-and-white) SMPTE timecode is preferred, the X1 will accept 24 fps, 25
fps, and 29.97 fps drop-frame (color) timecode as well. Format detection is automatic. You can even
play pre-programmed shows with a timecode format which is different from the one originally used for
programming.
Sync Out
This unbalanced, mono audio output serves two purposes on the X1. Whenever the X1 is set to External
Timecode Mode, this connector provides a ‘reshaped’ version of the timecode present on the Sync In
connector.

This can be useful for chaining equipment onto the same timecode source without using additional audio
equipment. Or, it can be helpful when another piece of equipment is having difficulty reading a weak or poorly
shaped SMPTE signal.
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When the X1 is set to internal clock mode, this connector generates the current system time during
playback and recording in 30 fps non-drop (black-and-white) SMPTE format. This signal can be used to
record a sync track or to directly drive other SMPTE compatible equipment.
X1 Sync Out
Sync In

Additional SMPTE
Compatible
Controller

X1 System

Example 1:
Internal Clock Mode
X1 as Master

X1 Sync Out
Sync In

X1 Sync In

Audio Out
X1 System

VCR

Additional SMPTE
Compatible
Controller

Example 2:
Timecode Mode
VCR as Master

USB Connector
The Universal Serial Bus (USB) port is used to connect the X1 Controller to your PC. Only Full Speed,
USB 1.1 Compatible cables, as the one provided by Innovate Show Controls, should be used.
AC Power
The X1 operates on 100 to 240 volts AC, 50 to 60 Hz. A three prong NEMA 5-15 P Plug cable is
provided for North American operation. If you need a different AC cable, the power entry module on the
X1 Controller conforms to the IEC 320 standard. This connector is not present on the X1-Mini.
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4 Quick Start Tutorial
Now that you have installed the X1 hardware and software and connected it to some fixtures, it is time to
create a show. If you have skipped the first chapters of this manual and jumped directly here, good for
you! This is where the fun begins. But, you might want to go back and read the portion of the
Introduction called ‘Terms and Concepts You Should Know’. This tutorial will use a number of the
terms described there without explanation (since the author of this manual is foolish enough to think that
you will read this document from beginning to end, feverishly clinging to every word).

4.1 Starting the Application
You can start the X1 system by either selecting Programs\BlueLite\BlueLite X1 from the Windows Start
menu, or by double clicking the desktop BlueLite X1 icon installed by the X1 Installation program.

If no hardware is detected (generally a sign that the X1 Controller is either turned off or not connected via
USB) you will be asked if you want to proceed in ‘Demo Mode’.

Demo Mode is unrestricted with all software features available. It can be used to complete this tutorial or
to examine and edit shows in situations when your hardware is not readily available.
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4.2 The Main Screen
Whether you are in Demo Mode or connected to your X1 Controller, the first screen that appears after
you start the application is the Main or ‘Console’ window. This is where you access the X1’s Grand
Master (lower left corner), XY Crossfaders (upper left corner), and 24 Submasters.

Each time you run the application, it will automatically load the last show used, along with the previous
Submaster Cue assignments. The name of the loaded show appears in the window’s title bar.
If you are running the application for the first time, or have selected ‘New Show’ from the ‘File’ menu or
toolbar, your window should look like above, with no name yet assigned to the show, and all Submasters
assigned to a built-in dummy Cue (0).

4.3 Creating Devices to Control
The starting point for a new show with the X1 is generally creating Devices. This is done using the X1’s
Device Manager. The Device Manager can be accessed via ‘Device Manager’ under the ‘Window’ menu
on the Main Window, or by selecting the Device Manager button on the Main Window’s toolbar:
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You can quickly go between the X1’s primary windows by pressing <ctrl>1 through <ctrl> 6.
However it is invoked, the Device Manager consists of two parts.

The right, larger pane shows created Devices and their location and channel usage in the X1’s 16 DMX512 Universes. You can view one universe at a time by selecting the appropriate tab at the top of the
screen.
The left pane shows a list of available Templates. Templates are organized in Folders, normally named
for a particular equipment manufacturer. For the first device in the show, you will be creating a Device to
control ‘footlights’ that uses the first six channels of Universe 3.
First, click the ‘DMX Output 3’ tab at the top of the window to show Universe 3.
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Next, expand the ‘Generic’ Template folder (click on the ‘+’ symbol) and click once on the ‘Console 6’
Template to select it.

Finally, point at channel 1 and click with the left mouse button to create the Device.

Since the default name ‘Console 6 1’ is not very meaningful, you can rename it. Click on the created
Device once with the left mouse button to select it. Now select ‘Rename’ from the ‘Device’ menu.

When an item is selected on an X1 screen, you can normally click with the right mouse button to bring up a
popup menu for most edit operations.
Once the Device’s name is highlighted, type in “Footlights” and press <enter>. The window will now
reflect the change.
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Now add 10 High End Systems Technobeams starting at channel 33 in Universe 1. Again, start by
selecting the appropriate Universe Tab and highlighting the “Technobeam (TB-F)” Template in the ‘High
End’ folder.

There are often different Templates for the same fixture included with the X1. This is so the fixtures can be
used in their different available modes. When possible, the Template name will include the manufacturer’s name for
a mode in parenthesis at the end.
You may insert the Devices one at a time or get fancy. To multi-insert, point at channel 33 then click
with the left mouse button and, holding the left mouse button down, begin dragging the mouse downward.
The Device Manager will ‘fill’ the adjacent channels with Technobeam Devices. By releasing the left
mouse button near channel 195 you will end up having created 10 new Devices.

You could, of course, rename the Devices if their default names are not meaningful enough. But that
would require thinking up 10 interesting names for this tutorial. Also, the next logical step, creating
Cues, is a lot more fun, so…
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4.4 Creating Simple Cues
Close the Device Manager by selecting the small ‘x’ in the upper right corner of the window.

You can open the Device Manager to add, delete, and/or move Devices at almost any time; even when the
X1 is playing back Event Lists!
Once the Device Manager is closed, open the Cue List by selecting ‘Cue List’ from the ‘Window’ menu
on the Main Window or selecting the Cue List button on the Main Window’s toolbar.

Your Cue List will be empty because this is a new show.

Insert the first Cue by selecting ‘Insert Cue…’ from the ‘Edit’ menu.

The X1 has keyboard shortcuts for most common operations. For example, <ctrl>I will insert a new Cue into
the Cue List. Shortcuts are shown in menus next to the operation they represent.
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When inserting a Cue, the X1 always prompts for a Cue Number, a Cue Name, and a Cue Description,
although only the Cue Number is required. It must be a unique number between 1 and 1,000,000.
Cue Names are best kept short as they are displayed in the limited space available beneath Submasters on
the Main Window. Cue Descriptions can be your life’s story if you are so inclined.
For the first Cue, use Cue Number 100 and ‘Green Foot’ for a name. After selecting OK, the new Cue
appears in the list.

Now that you have a Cue, you will want to open it in the X1’s Cue Editor. Do this by either double
clicking on the Cue Number in your Cue List, or clicking on the Cue Number once and then selecting
‘Edit Cue…’ from the ‘Edit’ menu.
Since this is a new empty Cue, the system will start by asking you to add some Devices into it.
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For this Cue, add the ‘Footlights’ Device by clicking on it to select it and then pressing the ‘Add’ button.

Since you are finished adding Devices for this Cue, click on ‘OK’.

You can also add and remove Devices by ‘double clicking’ on the name. Double click on “DMX Devices” at
the top of the list to add or remove all devices.

You can add and remove Devices to/from a Cue later by selecting ‘Add/Remove…’ from the ‘Devices’ menu
in the Cue Editor.
Since there is only one Device in this Cue, it is selected and displayed automatically in the Cue Editor.
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The X1’s Cue Editor is divided into two parts. The left pane shows a list of Devices that will be affected
by the current Cue. The right pane shows the settings for the Device (or Devices) selected in the left pane
for this Cue.
Since this is a new Cue, the Device starts with all levels at their default (normally 0). For the Green Foot
look, move the first two faders to 100% using the mouse.

If you are using your X1 hardware (not in Demo Mode) the first two channels on your 3rd universe (Out
3) will now be at full (255). This is because the X1 assigned the Cue to an XY Crossfader the Cue Editor
opened.

Important Note: This automatic assignment will not occur if the X1 is playing an Event List (preprogrammed show). The Cue Editor can still be accessed but Cues must be edited ‘blind’ or manually
assigned to a Submaster for onstage viewing.
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Now that you have created the fabulously sophisticated Green Foot look, you can create another. Instead
of going back to the Cue List and starting from scratch, just use your current Cue as a starting point.
Select ‘Duplicate…’ from the ‘Cue’ menu at the top of the Cue Editor window.
Using Duplicate and then modifying an existing Cue is often faster than creating a new Cue from scratch.
Again, you will be prompted for a Cue Number, Name, and Description.

For this second Cue, enter a cue number of 101 and change the name to Blue Foot. After selecting ‘OK’,
the title bar in the Cue Editor will change to reflect the new Cue. The new Cue will also have been
automatically assigned to an XY Crossfader.
Alter the new Cue so that faders 1 and 2 are at 0% and faders 3 and 4 are at 100%.

You can use <tab> or <shift><tab> to step through available controls in the Cue Editor and then use <Page
Up> and <Page Down> to quickly take them to 0% or 100%.
Now that you have the hang of it, use Duplicate to create a third look numbered 102 and called ‘Red
Foot’ with faders 1 through 4 at 0% and faders 5 and 6 at 100%. Now that there are some basic Cues for
the Footlight Device, it is time to create some more sophisticated Cues using the Technobeams.
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4.5 Creating More Sophisticated Cues
Instead of going back to the Cue List, you can insert a new Cue directly from the Cue Editor using the
same <ctrl>I shortcut (or ‘Insert Cue…’ under the ‘Cue’ menu). Make the new Cue number 200 with the
name ‘Upstage Fan’. Again, since this is a new Cue the X1 will again ask you to insert some Devices.

For this Cue add all of the Technobeams. But instead of selecting and adding the fixtures one at a time,
select the first Technobeam by clicking on it with the left mouse button and then select the last
Technobeam by clicking on it while holding the <shift> key. Once all the Technobeams are highlighted,
click the ‘Add’ button to insert them all into the Cue.
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In addition to using <shift>click to select a block of Devices, you can use <ctrl>click to select multiple
Devices that are not in order.
After clicking ‘OK’ the first Technobeam Device is selected by default in the Cue Editor.

Of course, the Technobeam Devices each have a few more controls than the simple ‘Footlights’ Device.
Rather than selecting each Technobeam individually to center it, open its shutter, and activate its dimmer,
start by using <shift>click to select all the Devices in the Cue Editor’s left pane – just as you did in the
Add Devices dialog box above. This selects all the Devices for simultaneous editing.

Devices created from the same Template can be simultaneously edited using the Cue Editor.
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Set all the fixtures to center, open shutters, and dimmers to full by clicking on the center of the Position
Control, selecting the Open tab on the Shutter Mode Control, and bringing the Dimmer Fader to 100%.

Next, use <ctrl>click to select just the odd numbered Technobeams and set their Color Wheels to Indigo.
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Use <ctrl>click again to select just the even numbered Technobeams to set the color to Red.
Finally, select the Technobeams individually and adjust their position using the Position Control to create
an upstage fan look.

Now that you have a nice Upstage Fan, you can use the Duplicate menu to create, what else, a
‘Downstage Fan’. Give it a Cue Number of 201. Editing the new cue, again use <shift>click to select all
the Devices in the Cue.
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Notice that the Position Control simultaneously shows the position of every selected fixture.
Using the down arrow on the position control, shift all of the fixtures from their original position in the
new Cue.

When multiple Devices are selected in the Cue Editor, most controls can be used to make either absolute or
relative settings. For example, clicking on the main area of the position control would set all selected Devices to the
same pan/tilt values. But using the arrows on the edge of the control moves all the selected fixtures relative to their
original position. The same is true of the arrow keys on faders and combo boxes. Clicking mode controls (tabs)
always makes absolute settings since they have no arrows.

Using the arrow buttons on a control, you can click once for a tiny step. Click and hold the left button down
on the arrows to make larger changes. The control will accelerate automatically.

If your mouse has a scroll wheel, you can adjust tilt (relative) by spinning it. Holding down the <control>
button causes the scroll wheel to adjust pan (relative). You can also press the scroll wheel to put the fixture(s) in
‘tracking’ mode, where the fixtures will ‘chase’ the mouse arrow from their current position. Pressing the scroll wheel
again releases the fixture(s).
Although the ability to simultaneously edit multiple fixtures does make moving lights easier to program,
complex movements can still require many Cues. Also, moving most fixtures on a curved path remains
difficult. So, for the last two Technobeam Cues you will use the X1’s Effect generation capability.
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4.6 Adding Effects
It should be understood that, unlike many of the other features offered on the Technobeam Cue Editing
screen, Effects are provided by the X1 Position Control, not the fixture itself. Effects are available on any
Device created from a Template that includes a Position Control. (See the Template Editor Chapter later
in this manual for more details.)
Before turning on effects, start by Duplicating your ‘Downstage Fan’ Cue to cue number 202 and calling
it “Marching”.
Once the new cue is created, use <shift>click to select all the Technobeams and use the up arrow on the
position control to move the fan to center stage.

Next, select ‘Line’ from the combo box at the top of the position control. All of the fixtures will now
begin sweeping up and down stage in sync. The movement for each fixture is centered in the fixture’s
current setting in the position control.
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You can adjust the speed and range of the sweep using the Speed and Gain faders on the right hand side
of the position control. The Reverse checkbox causes the selected Effect shape to be scanned in reverse.
However, with the selected Line shape this has no real visual effect.

The Rotation fader can be used to shift the Effect shape +/- 360 degrees along the z-axis. Use <ctrl>click
to select the even numbered Technobeams and set their rotation to +180.0 degrees:
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You can use the arrow buttons on faders and position controls to make very fine adjustments.
Now every fixture is 180º reversed from the fixture next to it, which is why its called ‘Marching’.
Important notes about effects:
•

Every position control has its own built in effect generator. This means that every fixture can be
set to its own shape, direction, speed, gain, and rotation.

•

When an effect generator transitions from off (no effect) to on (a selected shape) it begins
drawing the shape from the beginning. So, if you want to ‘synchronize’ the effects generators in
multiple fixtures (as we have done here), transition from a cue where all the effects generators to
be synchronized are off to a cue that has the shapes and speeds, etc., that you desire.

•

Effect shapes clip when they hit the limit on the Position Control (max pan or tilt value for the
fixture).

•

Effect shapes can be crossfaded. That is, an Arc will slowly morph into a Circle and so on.

Because of the motor speed on some fixtures and the limited update rate of the DMX-512 standard, effects
may appear a bit ‘jerky’ on some fixtures at some settings. If the fixture has a motor speed control, slowing it slightly
can often smooth this out.
In order to try effect crossfading, Duplicate the Marching Cue to Cue number 203 and name it ‘Hula’.
Once the new Cue is created, use <shift>click to select all the Technobeams and change the Effect shape
from ‘Line’ to ‘Sinewave’. Now that you have a collection of looks, you can try some fades and
crossfades.
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4.7 Assigning Cues to Crossfaders and Submasters
In order for a Cue to be displayed on stage, it must be assigned to either a Submaster or an XY
Crossfader. Return to the Main (‘Console’) window using <ctrl>1, <alt><tab>, or a mouse click.

Before displaying cues onstage, you will want to make sure that the Grand Master (labeled “GM” in the
lower left corner of the screen) is at 100%. Otherwise, some Cue channels will be displayed at a lower
level than expected.
Important Note: The Grand Master does not affect all 8192 DMX-512 channels. Only faders marked
“Grand Master Controlled” in a Template are adjusted (see Chapter 11, Template Editor). All the faders
in the ‘Footlights’ Device are configured this way, so all are doused by the Grand Master. On the other
hand, only the Dimmer channel in the Technobeam Template is configured for Grand Master control, so
lowering the Grandmaster only dims these fixtures. It does not move them or change their color and
effect modes.
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With the Grand Master up, you are ready to assign your Footlight cues to the first 3 Submasters. The
easiest way to assign a Cue is to right-click on the Submaster you want to assign a Cue to and pick
‘Assign Cue…’ from the pop-up menu that appears.

Alternately, you could use <tab> or <shift><tab> to highlight the fader you wish to assign and select
‘Assign Cue…’ from the ‘Submaster’ menu at the top of the window. Either way, you will be prompted
to enter a Cue number. Enter 100 and select OK.

The ‘Green Foot’ Cue will now be assigned to the Submaster. The Cue Number is displayed on the
Bump Button below the fader, and the button is now labeled with the Cue Name. You now can adjust the
fader to display the ‘Green Foot’ Cue at different percentages onstage. Alternately, you can force the
fader to full (100%) by click and holding the left mouse button on the Bump Button.

Bump Buttons for the 24 Submasters can also be activated by pressing and holding ‘1’ to ‘=’ keys
(Submaster 1 thru 12) and the ‘q’ to ‘]’ keys (Submaster 13 thru 24) on the keyboard. But, be forewarned, most PC
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keyboards are implemented as a ‘scanned matrix’. This means that only a few keys can typically be simultaneously
depressed, and some key combinations cannot be properly detected at all. If you need to aggressively chase and
bump Submasters live, you might consider using a basic DMX-512 console attached to the X1’s DMX-512 Input for
control.
Assign the other two Footlight Cues (101 and 102) to Submasters 2 and 3.

Submasters work ‘additively’, so you can now blend the three Footlight
Cues together at different levels by adjusting these Submasters.

If you create a Submaster/XY Crossfader combination that you like you can save it to a single cue by
selecting ‘Snapshot’ from the ‘Tool’ menu on the Main (Console) window.
Assigning Cues to the XY Crossfaders is very similar to assigning a Submaster. The only difference is
that the ‘Assign Cue’ dialog accepts two Cue Numbers. Start by assigning the Upstage and Downstage
Fan Cues (200 and 201).
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The XY Crossfaders do not have Bump Buttons, but they can be adjusted individually with the mouse, or
moved in unison using the slider between them.

When XY Crossfaders have ‘focus’ (are highlighted) you can crossfade smoothly using the up and down
arrow keys on the keyboard.
Crossfading Cues 200 and 201 will cause all the Technobeams to move between their upstage and
downstage positions. If colors or effects were different, they would switch smoothly as well.
If you try assigning Cues 202 and 203 (March and Hula) to the Crossfaders, you will find that Effect
shapes ‘morph’ when you crossfade! And, of course, you could add in Footlights using the Submasters as
well.

Bringing one Submaster down (100% to 0%) while bringing another Submaster up (0% to 100%) will also
crossfade cues. The XY Crossfaders are simply easier to move in unison when only the mouse or keyboard is
available. If you want to smoothly fade between cues using Submasters, consider using an external DMX-512
console to drive the 24 Submasters using the X1’s DMX In connector.

Remembering that Submasters work additively can help when performing live shows. For example, you
could create a series of cues with your Technobeams at various positions, in white, with no effects. Then create
another series of cues that leave the Technobeams at a position of 0,0, but have color and effect settings. You can
then assign all these cues to the X1’s 24 Submasters and mix position only cues with color/effect only cues to get a
wide variety of ‘looks’ quickly.

4.8 Creating a Simple Event List to Play
Now that you have added Devices, created Cues, and played with them manually, it is time to explore
some of the X1’s pre-programming and automation features. Pre-programmed shows are created as
Event Lists that, in turn, automate the X1’s XY Crossfader pairs. Bring up the Event List window by
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either Selecting ‘Event List’ from the ‘Window’ menu, or by selecting the Event List button in the Main
window’s toolbar.

The Event List window actually contains four separate Event Lists, which can each be selected for
viewing and/or editing using the Tabs in the upper left corner of the window.

As mentioned previously, each Event List has its own XY Crossfader pair associated with it. Whenever
an Event List is selected for viewing here, its corresponding XY Crossfader pair is shown on the Main
(‘Console’) window.
While working through this portion of the tutorial, you may find it helpful to arrange the X1’s windows
so that you have the Event List window in front, and the XY Crossfaders on the Main window visible in
the background. This way, you can actually see the results as an Event List automates these faders.

An X1 Event consists of a Time, a Fade Time (or Times, if the fade out and in times are different), a Cue,
and an optional Comment.
Even though this is a new Show, each of the four Event Lists already has one Event in it.
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These ‘preshow’ Events are fixed at a time of 00:00:00:00. Time is in the format of HH:MM:SS:FF, or
hours, minutes, second, and frames (always 1/30th of a second). By default a preshow event has a fade
time of 0.0 (seconds) and is assigned to the dummy Cue 0 (fixed at all channels at 0).
Insert a new event at 00:00:10:00 (10 seconds) either by selecting ‘Insert Event…’ from the ‘Edit’ menu,
or by pressing <ctrl>I and entering the desired time in the dialog that appears.

On the X1, times can be entered with almost any separator, or even no separator at all. For example,
“0,0,10,0”, “10.0”, “00001000”, and “10:00” would all enter a time of “00:00:10:00”.
Next, click on the Cue Number (0) in your newly created Event and change it to 100.

You have just programmed this Event List so that it will switch to the Green Foot Cue 10 seconds into the
show.
Insert two more Events and edit their Cues so that your Event List switches to Blue Foot (101) at 20
seconds and Red Foot (102) at 30 Seconds.

It is easiest to manually create Events first, then fill in their Cue numbers one after another. Each time you
press <enter>, the X1 will advance to the next Cue Number entry field.
Now that you have created a simple Event List, you need to become familiar with the Event List
window’s Transport Controls and Status area.

This is located in the upper right corner of the Event List window and consists of the following:
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•
•
•
•

3 Transport Controls used to control the List
A Mode Control, which determines how system time is driven (Internal Clock, External
Timecode, or <space bar> Single Step)
A System Time display/edit field
A Timecode Status area (invisible when not in external Timecode mode)

Press the Play button. Time will begin incrementing in the display and, at the appropriate times, your
Events will be triggered. Two markers show the List’s progress:

This circle indicates the last Event triggered and the triangle indicates the next Event scheduled to be
triggered. The XY Crossfaders on the Main window will also show your List’s progress.

When the List reaches the end stop the Internal Clock by pressing the Stop button. You can jump to
anywhere in the list by manually entering a new time in the Time display and pressing Play again.
You can also go to a specific Event and System Time by clicking on the gray area to the left of an Event
and then selecting ‘Set Current Marker’ from the ‘Edit’ Menu.

The quickest way to move around an Event List in Internal Clock mode is to double-click in the gray area
next to an event. This sets the current marker to the event and the system time to match.
Important notes about Event Lists:
•

Even though you are only viewing one Event List, all four lists play simultaneously, unless an
Event List is disabled using the checkbox in its selection tab.
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•

Closing the Event List window does not affect the transport controls. If the Lists are playing,
they will continue to do so even if the window is hidden.

As it stands, your current Event List will jump between Cues (no fade time). Experiment with clicking on
the Fade field for different events and changing the crossfade time used to transition into each Event.
Fades are also reflected on the XY Crossfaders, so you can see them even if you do not have any real
fixtures attached to the system.
By default, previous Cues fade out at the same rate as the new Cue specified by an Event fades in.
Sometimes you may wish to make these times different. You can do so by ‘splitting’ the fade time. To
split a fade time, either right-click on an Event and select ‘Split Fade’ in the popup menu, or select
(highlight) an Event and select ‘Split Fade’ in the ‘Edit’ menu. Once split, the Out and In times for an
Event can be edited separately.

4.9 Adding a Loop
For argument’s sake, let us assume that the Foot Light Cues and 30 second sequence with fades that you
have created is so breathtakingly beautiful that the powers-that-be would like it to repeat until four
minutes into the show.
One way to accomplish this would be to use Copy and Paste. The Event List window’s copy and paste
features are fairly sophisticated (see the Event List chapter later in this manual). Using these features you
could:
•
•
•
•
•

Insert a new, placeholder, Event at 00:00:40:00.
Highlight the three Events starting at 00:00:10:00 by clicking and dragging the mouse in the gray
area to the left of the events
Select Copy
Highlight the placeholder Event
Select Paste

This is a useful technique, and it would cause your magnum opus of Foot Light art to repeat once.
However, it would still be a bit of work for you to it extend it out to 4 minutes this way. A better
technique would be to use an Event Loop.
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In order to create an Event loop, you will need to insert two additional events to your original list:
•
•

An Event that marks when you want the Loop to repeat (loop back to the beginning)
An Event that marks when you want the Loop to end

As with the Copy and Paste method above, the Repeat point is 00:00:40:00. And, the powers-that-be
have told us that the loop ends at 00:04:00:00. So insert a new Event into your list at both of these times.

At four minutes, the head honcho wants to make a 5 second fade to the Blue Foot Cue. So, change the
Cue and Fade in the Event at 00:04:00:00 accordingly.

Last, highlight the four Events beginning at 00:00:10:00 (the three original Events and the ‘repeat’
placeholder Event) by clicking and dragging the mouse in the gray area to the left. When the Events are
highlighted, select ‘Loop’ from the ‘Edit’ menu (or right-click popup menu).

The next time the List plays, it will repeat your masterpiece until 00:04:00:00. It will then make a 5
second fade from wherever it happens to be in the loop to Cue 101.

You do not have to worry about timing loops exactly. The X1’s loop logic is smart enough to avoid partial
fades, etc. when a loop ends.
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4.10 Creating an Event List the Easy Way (with Record)
It is well accepted among educators that a single lesson, or even an entire curriculum, is never ideal for
every student. A presentation that uses “Where’s the Beef?” and “Just Say No!” repeatedly for analogies
may bewilder even the brightest non-U.S. student (or, for that matter, any student under the age of 40).
But, if you have worked through the last two sections in this tutorial you have almost certainly learned
one thing. Inserting Events into an Event List manually is extremely tedious!
Thankfully, there is a much easier way. It is called Record. You can use it to create a second Event List
for your Technobeams, which will run concurrently with the Foot Light spectacular you just created.
Start by selecting Event List 2.

Make sure that the Stop button is pressed and double-click the gray area next to the preshow Event to
force the system time back to 00:00:00:00.
Now, press the Record button (to the right of the Stop button). Time will begin incrementing and, even
though the list is hidden, the original Event List will be playing.
Now, begin listening to music in your head. Something along the lines of AC/DC’s Dirty Deeds Done
Dirt Cheap. If that selection offends your taste or sensibilities, feel free to select something else. If, like
Roadie Steve, you are a bit rhythmically impaired use something simple, like Mary Had a Little Lamb.
Whatever your selection, begin striking letter keys in rhythm. Events will be automatically inserted in
your new list at the time you struck each key.
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Notice that the keystrokes were entered as comments in the created Events. Now, instead of trying to find
and enter times manually, you can just press Stop and then enter Technobeam Cues and fade times (if
any) into the inserted Events.

You can save even more steps by pre-assigning letter keys to specific Cue Numbers. To do this, select
‘Assign Record Keys…’ under the ‘Settings’ menu. Once a key is assigned, striking it in Record will create an Event
with the designated Cue already entered.

Events can also be recorded from the Submasters. Bringing a Submaster to full (100%) using either the
mouse, keyboard, or an external DMX console while the X1 is recording will create an event at that time and insert
the Cue currently assigned to the Submaster (if any) into it.
Important notes about Record:
•
•
•

Record works in Timecode Mode as well. Just play the SMPTE source and strike keys to capture
event times that are synchronized to it.
If an Event already exists in the List with the same time, the key stroke will be ignored.
Do not worry about mistakes, it is easy to delete Events and try again!

If an Event time is just a bit off, hold the <ctrl> key and click on the time with the left or right mouse buttons
to increment it or decrement it. This is easier than doing frame math in your head.

4.11 Playing your Show with Timecode
So far you have been working in Internal Clock mode, where a crystal in the X1 hardware provides
system time. For the most part, working in Timecode mode is almost identical.
The tutorial steps above would remain the same, the only changes would be that system time would only
advance when the external timecode signal was present, and the status of the external signal would be
shown.
Waiting for timecode

Valid timecode present
Timecode lost, auto switch to Internal Clock
has occurred
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Timecode mode also has two additional settings, which are saved with a show. They can be configured
by selecting “Timecode Settings…” under the ‘Settings’ menu in the Event List window.

The first option controls how the X1 reacts when a timecode signal is lost during Play or Record. It can
either stop, and then relocate and re-sync when a signal is detected again, or it can switch to Internal
Clock mode and continue running the show. As the dialog indicates, one mode is generally more
convenient for show programming and the other may be more desirable for actual performances.
Important Note: When the ‘Automatically switch to Internal Clock’ feature is triggered, the X1’s Sync
Out connector does not begin generating SMPTE timecode based on the X1’s internal clock. The Sync
Out connector continues to mimic a reshaped copy of whatever signal is present on the Sync In connector.
The second setting, a Timecode Offset, can be used to ‘shift’ received timecode before using it for the
X1’s system time. You might wish to do this if you receive a new master with the SMPTE timecode
shifted (even though the Producer swears it is the same), or if you just want your Event times to start at
00:00:00:00 even though the SMPTE recording starts at 00:58:45:00 (so you can determine how long
until your next smoke/coffee/vegetate break without using a calculator).

You can change both of these timecode settings while the X1 is already Playing or Recording. This makes it
easier to determine Timecode offsets experimentally and allows you to enable Automatic Internal Switch mode even
after a performance has started.

4.12 Automating the XY Crossfaders with the LivePanel
Although the X1’s Event Lists are very powerful, some shows require rapid and random access to
sequences of cues. Enter the LivePanel. The LivePanel is actually a companion application which
automates the X1’s crossfaders using the X1’s Automation API (see the appendix in this manual). But it
is closely integrated with the main X1 application. For example, LivePanel settings are saved in the same
show file (see the next section).
To launch the LivePanel, select “LivePanel…” from the “Tools” menu on the Main Screen.
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After a splash screen, the following window will appear.

The appearance of the LivePanel is ‘skinned’. Use the ‘Config’ button to change skins and to download
new, specialized skins from www.innovateshowcontrols.com (ex. touch screen skin, MIDI skin, etc.)
The bottom portion of the LivePanel contains four ‘Chasers’ or ‘Sequence Players’. The chasers all run
concurrently and independently and can either be used independently or in crossfade matched pairs.
You select a chase for configuration either by clicking on it with the mouse or by pressing the associated
number key on your keyboard (‘1’ for chase 1, ‘2’ for chase 2, etc.).

For quick keyboard operation all chasers use the same ‘shortcut keys’ for setup. On the default skin all
LivePanel shortcuts are displayed and underlined. For example, ‘+’ for increase speed, ‘V’ to save a sequence, and
etc.
To create a simple sequence in Chase 1, first select the chaser, then either click on the ‘Cues…’ button or
press the ‘C’ key on the keyboard. In the dialog box that appears, enter the three footlight cue numbers
separated by spaces or commas.
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Once the OK button is selected, the sequence will be placed in the Chaser and the first Cue displayed
using an X1 Crossfader pair.
The sequence can be manually advanced using the ‘Step’ button (‘T’
key) or automatically sequenced using the Transport buttons. ‘F’ for
forward, ‘R’ for reverse, and ‘B’ for bally (back and forth).
The speed of sequencing is controlled by the right hand fader. ‘+’
for faster, ‘-‘ for slower, ‘]’ for full speed (1/25 a second), and ‘[‘ for
slowest (10 seconds). Speed can also be set by clicking on the ‘Tap’
button (spacebar).
The level a cue is displayed at is controlled by the left hand fader.
Up arrow for higher, down arrow for lower, pageup for full (100%),
pagedown for off (0%).
Turning ‘Fade’ on and off (‘A’ key) determines if the chaser will
step between cues, or gradually fade based on the current speed.
Turning ‘Once’ on and off (‘E’ key) determines if a sequence will
repeat, or just play to the end (or beginning).

Once a chase is configured the way you want, the chase settings can be saved for Function Key recall into
the currently active chaser. Saved chase settings is called a ‘sequence’. To save a sequence, select ‘Save’
(‘V’ key). The following dialog box will appear.

Sequences can be given an optional name and/or
bitmap. You can also determine which portions of
the current chase settings will be preserved and
recalled. For example, you could just save the
Cues and the sequence would inherit all other
settings from the currently active chaser when
recalled.
Once you have provided a name and bitmap (if
desired) and determined what portions of the
sequence to save, you will be prompted to select a
function key combination for the sequence (ex.
<F1>, <Alt><F1>, etc.) The modifier keys allow
48 sequences to be saved.
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For more sequences you can use different ‘pages’ (selected using the page buttons at the top of the
screen). 24 pages of 48 sequences allows for more than 1000 sequences to be saved in a show.
The LivePanel can also be used to crossfade between Sequences or individual Cues. Select chase 1 (‘1’
key) and change the assigned Cues (‘C’ key) so that only Cue 200 is used. Cue 200 should not be
displayed onstage.
Next select chase 2 (‘2’ key) and change the assigned Cues (‘C’ key) so that only Cue 201 is used. Cue
201 is not displayed because, by default, Chase 1 and Chase 2 are a crossfade pair.

The fade level of each Chaser in
the pair is controlled by the
crossfade controls immediately
above them.
Left and right arrow keys to
adjust, <home> for Chase 1 full,
<end> for Chase 2 full.
To use both chasers
simultaneously select Disabled
(‘D’ key) next to the crossfade
controls
The crossfade controls are also a
good use of the built in
‘autofade’ modifier keys.
Instead of trying to fade
between chase 1 and chase 2
with the right arrow key and
being limited to your
computer’s key repeat speed
you can press <alt><end>.
This will give an automatic 3 second fade between Chase 1 (Cue 200) and Case 2 (Cue 201). The legend
of autofade modifiers is included on the lower left corner of the LivePanel default skin.

You can use autofade modifiers on Speed, Level, and Grand Master control as well as crossfade level.
For convenience, the LivePanel also includes Grand Master control so you do not have to toggle back and
forth to the Main screen. There are also four on/off buttons that can be used to recall individual cues (ex.
smoke machine, strobes, etc.)
You can turn on a Random function using the controls in the upper right corner of the LivePanel.
Random will recall a used Sequence from the selected row into the currently selected chaser at a variable
random rate.
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Some additional features you might want to explore are native MIDI input support and support for
external BPM sources. See the chapter on the Live Panel for more details.

Although the LivePanel uses the same XY Crossfaders as the X1 Event Lists, they do not have to be
mutually exclusive. The LivePanel uses XY Crossfaders in reverse order from the Event Lists (Chaser 1 uses the
same faders as Event List 4, Chaser 2 uses the same faders as Event List 3, etc.) You could pre-program a show
with Event Lists 1 and 2 and still have two chasers available on the LivePanel for manual portions.

4.13 Saving and Loading Shows
Now that you have added devices, created cues, and developed and played several Event Lists, it is time
to cover a few important notes on saving and loading shows.
•

Shows can be loaded and saved from all windows with the exception of the Template window.

•

Shows can also be opened and saved using the toolbar on the Main window.

•

When saving over an existing show file, the previous version of the file is renamed to
<filename>.bak (ex. ‘test.x1’ becomes ‘test.x1.bak’).

•

Shows are normally saved with the file extension “.x1”.

•

An X1 Show File contains Devices, Cues, Event Lists, Presets, Timecode settings, and Current
Submaster Assignments. It is the only file that must be transferred to play a show on another X1
System – even if custom Templates, etc. are used.

•

When an X1 show is loaded, all previously loaded Devices, Cues, Event Lists, Presets, and
Submaster Assignments are lost.
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4.14 Creating a Simple Template
Depending upon what equipment you typically use and what types of shows you normally run, you may
never need to generate an X1 Template. Stock templates and templates from other users (available at
www.innovateshowcontrols.com) may meet most your needs.
Or, you may be content making only small changes to stock templates, such are renaming controls,
moving a few channels used, etc. This is reasonable. The ‘Save As’ feature in the Template Editor was
even included expressly for this purpose.
But a good template can make show programming dramatically easier. It can also make Devices behave
much more predictably when you play Cues live using the X1’s Submasters. So this tutorial will wrap up
with creating a simple Template.
Hopefully this will encourage you to explore this powerful feature of the X1 system further. There is a
chapter dedicated to the Template Editor as well as a more comprehensive tutorial later in this manual.
The ‘Fixture’
The first thing you will need to do before you create a Template is to learn about the DMX-512 channel
usage of the fixture you plan to develop it for. You are in luck, Roadie Steve has just used plastic fiber
optic cable, hot glue, LEDs, his beloved Dremmel, a Furby™ doll, and electrical odds-and-ends to
transform a PAR can he found in a trash dumpster into what we will call the ‘SteveRay’.

According to Steve, the SteveRay uses three DMX-512 channels:
1. Brightness
2. Chase Pattern
3. Chase Speed
Of course, you do not need a new Template to start controlling the SteveRay with the X1. You can just
insert one of the Generic Console Templates included with the X1 and start creating Cues. But after
experimenting a bit, you discover the following:
Channel 1 works as expected, 0% (0) is off, 100% (255) is full brightness.
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Channel 2 offers five different patterns:
0%-19% (0-50)
20%-39% (51-101)
40%-59% (102-152)
60%-79% (153-203)
80%-100% (204-255)

No Chase
Sparkle
Horizontal
Vertical
Swirls

Channel 3 is a little odd. 10% (25) is the fastest chase while 94% (240) is the slowest. Levels below 10%
or above 94% appear to cause erratic behavior. In addition to the channel quirks, you have discovered
that it does not look nice when you put a SteveRay Cue (ex. full brightness, Vertical pattern, slow speed)
on a Submaster and fade it in. The brightness works as expected, but speed starts erratic, then appears
backwards (fast to slow), and you flash through different chase patterns as the SteveRay fades in.
To make matters worse, now that everyone has seen the SteveRay and fallen in love with it, you have
been asked to manually vary the speed to match an improvised musical medley in the middle of the show.
Since Submasters work additively, so you could create two Cues and blend them, using the second fader
to vary speed. But, the fader will be ‘backwards’ (since 10% is fastest), and you will have to be careful
not to exceed 94% or drop below 10% if you do not want erratic behavior.
Even with the generic Template, most of these problems could be circumvented. For example, you could
create two cues for every SteveRay look, one with the Brightness control at 0, the other full on, then
crossfade between these Cue pairs. This would allow you to fade in SteveRay ‘looks’ without the
changing chase patterns or bad speed settings. But a fixture specific Template would eliminate the need
for all this extra work.
Start by opening the X1’s Device Manager by selecting ‘Device Manager’ from the ‘Window’ menu on
the Main screen, or by selecting the Device Manager Button on the toolbar beneath it.

Once the Device Manager has opened you can create a new Template Folder for special items. Either
select ‘New Folder’ from the ‘Template’ menu or from the right click popup menu.

The new Template Folder will be displayed with its name
already selected. Type “Special” and then press the <enter>
key.
Next, select ‘New Template’ from the ‘Template’ menu or
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the right click popup menu.

Again, the newly created Template will be displayed with its name already selected. Type “SteveRay”
and then press the <enter> key. To open the new template for editing, either click on it once to highlight
it and then select ‘Edit…’ from the ‘Template’ menu or the right click popup menu.

You can also double click on a template in order to open the Template Editor.

As you can see, the Template Editor itself is simple. There is a toolbar of items that can be inserted and
the Template edit area itself. Items look the same in the Template edit area as they do in the Cue Editor.
The only difference being that the Template Editor has a visible grid to help with alignment.
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Examining the toolbar more closely you can see that there are only a few types of Controls that can be
inserted.

•
•
•
•

Fader Controls are used for a basic sliders or faders
Position Controls are used for Pan/Tilt Channels and automatically include an Effects Generator
Combo Box Controls are used for non-fading channels
Mode Controls are for cases where multiple functions are combined on one channel or where the
affect of multiple channels is interrelated

The arrow at the top of the toolbar should be selected when you wish to manipulate an existing control
instead of inserting a new one.
To start, insert a Fader Control by first clicking on the Fader button on the toolbar and then clicking once
in the edit area of the Template.

Once you have a control (in this case a Fader) inserted into your template you can adjust its size and
position. Select the arrow in the toolbar by clicking on it and try adjusting the newly created fader. You
can move a control by clicking and dragging inside it. Sizing is done with the small adjustment boxes
around the Control. Once you have a size and location you are happy with, you can adjust the fader’s
properties.
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When inserting controls, you can hold down the mouse button to insert and/or resize the Control in one
operation.
When a control is selected (adjustment boxes visible), you can edit its properties by selecting ‘Properties’
from the ‘Edit’ menu. Make sure that the new fader is selected and bring up the Properties dialog box
now.

Double clicking on a Control also brings up the Properties dialog box.
The Name field is the text that will be displayed above the fader. Enter “Brightness”.
Grand Master Controlled determines if this fader is affected by the X1’s Grand Master. Since this is the
SteveRay’s intensity control, leave this checkbox selected.
Next, you need to indicate how many channels this fader will control. Faders can be used for either 1
channel (8 bit) or 2 channel (16 bit) control. Since the SteveRay uses a single DMX channel for
brightness, you can leave this at the default 1 DMX Channel setting.
In addition to specifying how many channels to control, you must also specify which channel(s) this fader
is intended for. Since Templates can be used to create devices anywhere in the X1’s 16 DMX-512
universes, you do not give a specific channel, but an offset for the control to use. Offset is relative to the
insertion point for a device, or:
Device Insertion Base Channel + Offset = Device Channel
Basically this means that 0 would indicate the first channel in a device, 1 the second channel and so on.
Since Brightness is the first channel in the SteveRay, you can leave the offset at the default value of 0.
On the X1 a fader does not have to go full range on a channel. Minimum and maximum values can be
specified. The SteveRay’s Brightness control is full range so, again, you can accept the defaults of 0 and
255.
The final option is used to configure a fader to operate in reverse. Since the Brightness control is
straightforward (0 lowest, 255 highest), you can leave this un-checked and select ‘OK’.
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Inserting a Combo Box is basically the same. Select it from the tool bar, click in the edit area to insert,
and use the arrow to adjust size and position.

When a control is selected in the Template Editor, you can adjust its location using the arrow keys and its
size using the <shift>arrow keys.
However, the Properties dialog box for a Combo Box is different.

Name and Channel Offset are the same. Enter “Pattern” for the name and 1 for the offset (since chase
pattern is channel 2 on the SteveRay).
The remainder of the dialog box is a table of DMX values and descriptions for the Combo Box. You
need to enter the following value/description pairs:
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Value
0
51
102
153
204

Description
Solid
Sparkle
Horizontal
Vertical
Swirls

When the dialog box is completed like the one above, select ‘OK’.

It is easier to enter all values and then all descriptions. Pressing <enter> moves you down the column after
each entry.

DMX Values can also be entered in Control property dialogs as either an absolute value (ex. “64”) or as a
percentage (ex. “25%”).
Last, you need to insert a fader for speed control. Insert and position it using the same steps you used for
the brightness control, but fill out the properties dialog like the one below:
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Name the fader “Speed”. It is not Grand Master affected.
The fader will be at offset 2 (since speed is channel 3 on the SteveRay). Its range is limited to 25-240,
since less than 25 and greater than 240 are bad values.
Finally, for good measure, the fader is reversed so that speed will be slow at the bottom and fast at the
top. This reversal is carried over to Submaster and XY Crossfader summing as well.
Once you select OK, take a final look at your template before saving it.

If you would like to look at a Template in the Template Editor without any adjustment blocks visible, select
the arrow in the toolbar and click on the background in the edit area.
After closing the Template Editor you will be prompted to save your changes. You can also save the
template without closing the editor by selecting ‘Save Template’ in the ‘File’ menu.
If you now create a device based on your new Template you will find that all of the issues you ran into
originally are addressed. You can place a cue on a Submaster and it will fade in or crossfade smoothly.
A bit more subtle, but just as helpful, speed is now reversed for control purposes. This is not just a visual
change in the Cue editor, but a behavioral change as well. Speed will work ‘additively’ (more equals
faster) on Submasters and XY Crossfaders as well.
On the off chance that you do not own or have access to an SteveRay to use in your shows, you can delete
both the ‘SteveRay’ Template and the ‘Special’ Template Folder by selecting the ‘Special’ Template
Folder in the Device Manager’s Template list, then selecting ‘Delete…’ from the ‘Edit’ menu.
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5 Application Overview
As the following diagram shows, most BlueLite X1 features are accessed using one of six windows. Each
of these windows is explained in detail in the following chapters. In addition to these screens there is a
helper application called the LivePanel, intended for interactive live playback, which is covered in
Chapter 12.

Main (‘Console’)

Event List

Cue List

Device Manager

Cue Editor

Template Editor

You can quickly go between the six main program windows by pressing <ctrl>1 through <ctrl> 6
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6 Main (‘Console’) Window

The Main Window is the first window that appears each time that the X1 software is started. It is primarily
intended to manage the display of Cues onstage using Submasters and XY Crossfaders. The title bar at the
top of the window displays the name of the currently loaded show.
Closing the Main Window will close all other open X1 windows and terminate the application. Closing any
other X1 windows only close that particular window but not the entire application.
There is a menu bar for file operations, Submaster configuration, and launching other program windows. A
complete list of menu operations can be found at the end of this chapter.
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Immediately below the menu bar is a tool bar for file operations and launching other program windows.

6.1 Console Controls
The remainder of the window is dedicated to the Console Controls. This area is broken down as follows.

XY Crossfaders

24 Submasters

Grand
Master

Bump
Mode

Working clockwise from the bottom left corner of the window are the following controls:
Grand Master

The Grade Master can be thought of as a master fader, or douser for the system.
Like a conventional lighting console, this control can be used to bring all the
fixtures connected to the system to black. However, this fader does not
necessary control all 8192 of the X1’s DMX-512 channels.
Templates determine which channels, if any, are Grand Master controlled in a
device. This allows the Grand Master to dim a moving fixture to black without
also moving its positions to zero.
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XY Crossfaders

XY Crossfaders are meant to work in unison. The right-hand ‘Y’ fader
is upside down in relationship to the ‘X’ fader so that the pair can
easily be used to transition between Cues (one Cue assigned to each
fader).
The X1 actually has 4 XY Crossfader pairs, each associated with a
particular Event List. Only one XY pair is displayed at a time. The
currently selected Event List will dictate which XY Crossfader pair
will be displayed even if the Event window is closed. The active XY
pair is highlighted in blue below the faders.
The Crossfaders can be used manually, either by adjusting one fader,
or using the center connector to adjust both faders simultaneously.
However, the Crossfaders are primarily intended for playing preprogrammed shows.
24 Submasters

Each of the 24 Submasters can be assigned a Cue. Submasters work
additively, both with each other and with the XY Crossfaders, so
Cues can be blended together.
Each Submaster includes a Bump Button. A bump button can be
used to force a Submaster to 100%. The exact behavior is
controlled by the Bump Mode (explained below).

Bump Mode

The Bump Mode controls are used to specify Bump Button behavior. In Flash
Mode, Submasters are forced full (100%) when buttons are pressed. In Latch
Mode, the Submaster toggles between forced full and normal with each press.
In Solo Mode, the Submaster is forced to full, while all other Submasters are
forced to off (0%) when buttons are pressed.
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6.2 Fader Basics
Although the faders on the Main window serve different purposes, they are all operated in basically the
same way from the user’s point of view. In the images on the previous page, notice that the Grand Master
is a different color than the other faders. This is because the Grand Master has ‘focus’.
Focus indicates that a particular fader will respond to key presses.
Key
Up Arrow
Down Arrow
Page Up
Page Down

Function
Increment Fader
Decrement Fader
Fader Full (100%)
Fader Off (0%)

Focus also determines which fader will be affected by the ‘Submaster’ menu operations.
You can use the <tab> and <shift><tab> keys to shift focus forwards and backwards through all the faders
in the window. Focus is also moved immediately when you use the mouse to control a fader.
The mouse can be used to control a fader in three ways. First, by clicking, holding, and dragging the
‘thumb’ (knob). Second, by clicking on the up and down arrows above and below the fader. Third you can
immediately set a fader to a particular level by clicking on the legend behind it.

You can make a small adjustment by clicking the increment or decrement button once. Click and hold these
buttons to make larger adjustments.

You can click just above or below the scale to force a fader to full or off.

If your mouse has a scroll wheel you can adjust a selected fader up and down with it.
6-4

However a fader is adjusted, its current level is displayed in percentage below it.

Faders that are assigned a Cue also display the Cue Name and Number below. Submasters display the Cue
Number on their bump button. XY Crossfaders display the Cue Number as text.

6.3 Additional Submaster Control Methods
In addition to the mouse and keyboard control available to all faders, Submasters can be controlled in three
additional ways:
•
•
•

Keyboard Bump Button Shortcuts
DMX-512 Input
Presets

6.3.1 Keyboard Bump Button Shortcuts
The following keys map directly to the bump buttons under the X1’s 24 Submasters.
Sub:
Key:

1
‘1’

2
‘2’

3
‘3’

4
‘4’

5
‘5’

6
‘6’

7
‘7’

8
‘8’

9
‘9’

10
‘0’

11
‘-‘

12
‘=’

Sub:
Key:

13
‘q’

14
‘w’

15
‘e’

16
‘r’

17
‘t’

18
‘y’

19
‘u’

20
‘I’

21
‘o’

22
‘p’

23
‘[‘

24
‘]’

Important note: Most PC keyboards are implemented as a ‘scanned matrix’. This means that only a few
keys can typically be simultaneously depressed, and some key combinations cannot be properly detected at
all. If you need to aggressively chase and bump Submasters live, you might consider using a basic DMX512 console attached to the X1’s DMX-512 Input for control (see the following section).

6.3.2 DMX-512 Input
Submasters and various other X1 features can be controlled from the X1’s DMX-512 Input. To use this
feature, select ‘DMX Input…’ from the ‘Submasters’ menu. In the dialog box, set the starting address from
the DMX input for control. Then enable any of the features you would like exposed for external control.
The dialog box will automatically report which physical DMX-512 channel(s) will be associated with each
enabled feature.
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By default, Submaster control is enabled and the 24 Submasters in the X1 will track the 24 associated
DMX-512 channels. Think of this as adding 8192 channels of moving fixture control to your generic 24channel DMX console. See the appendix at the back of this manual for a complete breakdown of the X1’s
DMX input protocol.

6.3.3 Presets
Presets can be used to instantaneously make Cue assignments to all 24 Submasters. To save a Preset,
configure the Submasters, then select ‘Save Preset’ from the ‘Submasters’ menu. Presets can be recalled by
selecting ‘Load Preset’ from the ‘Submasters’ menu.

You can use the function keys (F1 thru F12 and <shift>F1 thru <shift>F12) to quickly recall presets. Holding
<ctrl> will record a preset in the same location.

Remembering that Submasters work additively can help when performing live shows. For example, you could
create a series of cues with your Technobeams at various positions, in white, with no effects. Then create another
series of cues that leave the Technobeams at a position of 0,0, but have color and effect settings. You can then assign
all these cues to the X1’s 24 Submasters and mix position only cues with color/effect only cues to get a wide variety of
‘looks’ quickly. Combining this technique with Function Key recall of Submasters can give you a large number of
readily available combinations.

6.3.4 Snapshot
The Snapshot feature, located under the ‘Tools’ Menu, can be used to capture the current, combined, X1
DMX-512 output to a single cue. For example, a user could combine a position only Cue on one Submaster
with color and conventional lighting Cues on other Submasters to get a desired ‘look’. Snapshot would
then capture this look to a single Cue so that it can be played in an event list or displayed using a single
Submaster. Please note that Effects are not copied by snapshot.
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6.4 Menu Operations
File Menu
Entry
New Show
Open Show…
Save
Save As…
Exit

Description
Create a new, empty show
Open an existing show
Save the currently open Show
Save the current show to a different file name
Exit the X1 program

Submasters Menu
Entry
Load Preset
Save Preset
Assign Cue…
Clear All Assignments
Clear Submaster Assignments
Clear XY-Fader Assignments
Bump Button Mode
DMX Input…

Description
Load a Preset (assignment for all 24 Submasters)
Save a Preset
Assign a Cue to the currently selected fader
Clear all Submaster and XY Crossfader Cue assignments
Clear all Submaster Cue assignments
Clear all XY Crossfader Cue Assignments
Select Flash, Latch, or Solo mode for Submaster Bump Buttons
Configure DMX-512 input control

Tools Menu
Entry
Snapshot…
Live Panel…
ArtNet Output
Capture 3.0 (CITP) Interface
ArKaos (Artnet) Interface

Description
Capture the combined results off currently active Submasters
and XY Crossfaders to a single Cue
Launch the BlueLite Live Panel Application
Send all 16 universes over a LAN connection using the ArtNet
protocol
Establish a connection with LewLight’s Capture design
software
Establish a connection with ArKaos VJ DMX media software

Window Menu
Entry
Main Window…
Device Manager…
Cue List…
Event List…
Cue Editor…
Template Editor…

Description
Open the Main window
Open the Device Manager window
Open the Cue List window
Open the Event List window
Bring the Cue Editor to the front (if open)
Bring the Template Editor to the front (if open)

Help Menu
Entry
X1 Manual…
About…

Description
Open the X1 Manual in a PDF viewer (if available)
Display Application Version Information
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7 Event List Window

The Event List window is used to create pre-programmed shows on the X1. On the X1, pre-programmed
steps are called Events, and Events are collected into an Event List. The X1 has four Event Lists that can
be played concurrently. Each List works by automating its own dedicated XY Crossfader pair.

7.1 Window Layout
At the top of the X1’s Event List window there is a menu bar for file operations, Event editing, and Event
List related settings. A complete list of menu operations can be found at the end of this chapter.
The remainder of the Event List window is organized as follows:
List Selection and Control

Transport and Status

Event List
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7.2 List Selection and Control
Although the X1’s four Event Lists generally play concurrently, only one can be viewed at a time.
Selecting a tab brings an Event List to the foreground. This also makes the Event List’s associated XY
Crossfader pair visible in the upper left corner of the Main (‘Console’) window.
If, for some reason, you do not wish for one of the four Lists to play, you can select the ‘disabled’ check
box on the List’s selection tab.

Important Note: The ‘disabled’ option takes effect immediately whenever it is selected, if a List is
already being played. However, it does not force the XY Crossfaders associated with the Event List to
0%.

7.3 Transport and Status
The Event List window’s Transport Controls and Status area is located in the upper right corner of the
Event List Window. It consists of the following:

•
•
•
•

3 Transport Controls used to control the List
A Mode Control, which determines how system time is driven (Internal Clock, External
Timecode, or <space bar> Single Step)
A System Time display/edit field
A Timecode Status area (invisible when not in external Timecode mode)

The behavior of the Play button depends upon the selected mode:
Mode

Behavior

Internal Clock

System Time begins incrementing and Event Lists begin
executing based upon the Time indicated.

External Timecode

Time resets to 00:00:00:00 and Event Lists play in
response to external timecode once sync is established.

Step Mode

Play button advances to next Event in Current
(Displayed) List (same behavior as <spacebar>)

In both Internal Clock and External Timecode modes, the Stop button stops System Time from
Incrementing and Event Lists from playing.
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Record Mode is activated using the Record Button. It is only available in Internal Clock and External
Timecode modes. Behavior is identical to the Play button with the exception that events can be
automatically generating using keystrokes on the keyboard. Empty Events (only dummy Cue #0
assigned) can be inserted, or keystrokes can be associated with Cue numbers by selecting ‘Assign Record
Keys…’ from the ‘Settings’ menu.
While the X1 is not playing, a new System Time can be entered manually into the Time Display if you
are in Internal Clock Mode. However, this time will not take effect until either the Play or Record button
is pressed.

In Internal Clock Mode you can quickly select an Event and the current System Time by double-clicking
immediately to the left of an Event’s Time.

The easiest way to set the next marker in Step Mode is to double click on the left side of the Event List.
(Just like setting the current event in Internal Clock Mode.)

7.4 Event List
Most of the Event List window is used for displaying the Current (visible) Event List. A single Event
consists of time, fade out time for previous Cue, and fade in time for Event Cue (if different), a Cue, and
an optional Comment.

All four X1 Event Lists have a permanent event at time 00:00:00:00. This is sometimes referred to as the
X1’s Preshow Event.
Subsequent events are always sorted by time. Every Event in a given list must have a unique time.

Times are always expressed in the format HH:MM:SS:FF (hours, minutes, seconds, and frames [1/30th of
a second]). The X1 always uses 30 frames per second for display and editing, even when other SMPTE
formats (ex. 25 fps) are being used for external synchronization.
Events can be added to a list in four different ways:
•
•
•
•

Inserted manually using ‘Insert Event…’ from the ‘Edit’ menu
Keystrokes during Record Mode
Submaster input during Record Mode
Copy and Paste operations
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Once an Event has been added to the List it can be selected by either clicking on its time, or immediately
to the left of its time. Once one or more Events are selected, various operations can be performed using
the ‘Edit’ menu. For example, the Events can be copied, pasted over, have their fade times ‘split’
(separate out and in times), deleted, or converted into a loop.
Fields in an Event, such as time, fade time(s), Cue Number, and Comments, can be ‘in place edited’.
Simply click on them and enter the desired value.

Time, fade time(s), and Cue Number can also be incremented and decremented by holding the <ctrl> key
and clicking on them with the right and left mouse buttons.

7.5 Copy and Paste
The Cut, Copy, and Paste model on the X1 is much like a word processing program. An Event can be
copied in its entirety, or just portions (ex. Cue, Comment, fade times, etc.) can be copied from one Event
to another.
One special note is the handling of Time during paste operations. If three events are selected (by clicking
and dragging with the mouse), the display will look similar to the following:

Selecting ‘Copy’ from the ‘Edit’ menu will place these three Events on the clipboard. Another Event or
Events can then be selected.
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The selected Event(s) can then be used as an insertion point for Paste operations. The selected Event(s)
will be replaced with the Event(s) in the clipboard. However, the pasted Event(s) will use the insertion
point as a start time. Any subsequent events on the clipboard will also have their times adjusted relative
to this new time.

7.6 Looping
When three or more Events are selected by dragging the mouse, they can be converted into a loop by
selecting ‘Loop’ from the ‘Edit’ menu.

When Events are converted into a loop, the first Event’s time remains unchanged. This is the start time
for the loop. The times on the rest of the Events in the loop are converted to relative or delta times.
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The Cue and Fade times on the last Event in the Loop is disabled. This time becomes the loop-back or
repeat time. This is the relative time at which the Loop will go back to the first event in the loop.
Loops repeat until an Event after the loop is triggered. The X1 loop logic insures that a loop is not left in
mid-fade.
To ‘unloop’ events, simply select any Loop Event and choose ‘loop’ from the edit menu. This will deselect the entire loop. It is not possible to partially unloop a Loop Event, although you can insert or delete
events to/from an existing loop.

If you ‘unloop’ events then the delta times of the Loop Events will automatically convert to absolute event
times based on the start event of the loop. That means if you created a loop and you convert the loop back to regular
events, then you won’t loose any data.

7.7 Stop Flag
A Stop Flag may be set on any Event, from either the ‘Edit’ menu or the right click context menu. A Stop
Flag only has an effect in Internal Mode. When a Stop Flag is encountered in any active Event List, the
system will stop at that time, but will not trigger the flagged event. The marked Event will be triggered
immediately the next time Play is selected via the Mouse, <spacebar>, or an external DMX console.
This is particularly useful when triggering sequences of cues manually for a live show. For example,
<Spacebar> triggers a complicated sweep followed by a transition to all lights on a center stage position.
The next <spacebar> triggers a fade to black, followed by a setup to the next light position for fade in, etc.

7.8 Step Mode
From a programming perspective, Timecode and Internal modes are essentially identical. All active
Event Lists respond to the system time, regardless of how it is generated. Step Mode, selected in the
Transport controls, is slightly different. In Step Mode, only the currently visible Event List is advanced,
one event at a time. Order can be broken by changing the ‘Next Marker’ by double clicking or using the
‘Edit’ menu.
Each Event List maintains it’s own Step Mode ‘Next’ and ‘Current’ marker. This allows you to advance
one list several steps, switch to another list and advance it a step, then return to the original list without
losing your place.

7.9 Special Notes
The X1’s Event Lists use a mechanism called just-in-time Crossfader assignment and automation. Cues
are not assigned to Submasters, and Submasters are not assigned levels until absolutely necessary.
This allows the X1 Event Lists to exhibit some very nice behavior that a more conventional pre-cue and
trigger system does not. For example, when you start external timecode, X1 Event Lists synchronize
immediately, even if that means putting the system in the middle of multiple crossfades. Pre-cue and
trigger systems often do not fully synchronize until the next trigger time is met.
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However, operators who are used to other systems might be a little confused when watching XY
Crossfader automation on the X1. The onstage behavior will be what is expected, although the
automation of the faders that may appear a little unusual.
When the X1 is used in Step Mode, only the current, or visible, Event list is played.

7.10 Menu Operations
File Menu
Entry
New Show
Open Show…
Save
Save As…
Close

Description
Create a new, empty show
Open an existing show
Save the currently open Show
Save the current show to a different file name
Close the Event List window

Edit Menu
Entry
Cut
Copy
Paste
Delete
Split Fade
Stop Flag
Loop
Insert Event…
Set Current Mark
Set Next Mark

Description
Cut selected Event(s)
Copy selected Event(s)
Paste Cut or Copied Event(s) into the List
Delete selected Event(s)
Split Fade time to separate Out and In times for selected
Event(s)
Set a Stop Flag for the selected Event
Convert selected Events to/from a loop
Insert a new Event
Set the Current (last triggered) Event
Set the next event to be triggered (Step Mode only)

Run Menu
Entry
Play
Stop
Record
Mode
Set Time
Disable

Description
Play Event List(s)
Stop Playing Event List(s)
Record Events to current List
Select Internal Clock, Timecode, or Step mode for playing
Event List(s)
Set System Time, Stopped, Internal Clock Mode only
Disable one or more Event Lists

Settings Menu
Entry
Assign Record Keys…
Timecode Settings…

Description
Associate keys to Cues for Event List recording
Configure Timecode Lost Sync behavior and offset
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Tools Menu
Entry
Snapshot…
Live Panel…
ArtNet Output
Capture 3.0 (CITP) Interface
ArKaos (Artnet) Interface

Description
Capture the combined results off currently active Submasters
and XY Crossfaders to a single Cue
Launch the BlueLite Live Panel Application
Send all 16 universes over a LAN connection using the ArtNet
protocol
Establish a connection with LewLight’s Capture design
software
Establish a connection with ArKaos VJ DMX media software

Window Menu
Entry
Main Window…
Device Manager…
Cue List…
Event List…
Cue Editor…
Template Editor…

Description
Open the Main window
Open the Device Manager window
Open the Cue List window
Open the Event List window
Bring the Cue Editor to the front (if open)
Bring the Template Editor to the front (if open)
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8 Cue List

The X1’s Cue List window is intended for browsing Cues that have been created in the current show.
New Cues can be inserted to this list by Selecting ‘Insert Cue…’ from the ‘Edit’ menu at the top of the
window.
Existing Cues can be selected and duplicated using the ‘Duplicate…’ option under the ‘Edit’ menu. All
Cues, regardless of how they are added to the list, must be assigned a unique Cue Number. Cue numbers
can be any value from 1 to 1,000,000.
Any Cue in the list can be opened in the Cue Editor for editing by either double clicking on it, or selecting
with a mouse click and then choosing ‘Edit Cue…’ from the ‘Edit’ menu.

8.1 Menu Operations
File Menu
Entry
New Show
Open Show…
Save
Save As…
Close

Description
Create a new, empty show
Open an existing show
Save the currently open Show
Save the current show to a different file name
Close the Event List window

Edit Menu
Entry
Cut
Copy
Paste
Delete
Insert Cue…
Edit Cue…
Duplicate Cue…

Description
Cut selected Cue Name or Description
Copy selected Cue Name or Description
Paste Cut or Copied Cue Name or Description
Delete selected Cue or Cue Name or Description
Insert a new Cue into the Cue List
Open currently selected Cue with the Cue Editor
Duplicate the currently selected Cue to a new Cue Number

8-1

Tools Menu
Entry
Snapshot…
Live Panel…
ArtNet Output
Capture 3.0 (CITP) Interface
ArKaos (Artnet) Interface

Description
Capture the combined results off currently active Submasters
and XY Crossfaders to a single Cue
Launch the BlueLite Live Panel Application
Send all 16 universes over a LAN connection using the ArtNet
protocol
Establish a connection with LewLight’s Capture design
software
Establish a connection with ArKaos VJ DMX media software

Window Menu
Entry
Main Window…
Device Manager…
Cue List…
Event List…
Cue Editor…
Template Editor…

Description
Open the Main window
Open the Device Manager window
Open the Cue List window
Open the Event List window
Bring the Cue Editor to the front (if open)
Bring the Template Editor to the front (if open)
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9 Device Manager

The Device Manager is where Devices are created and mapped to the X1’s 8192 DMX-512 channels.
This window is also used to manage X1 Templates and invoke the Template editor.
There is a menu bar for file operations, Template editing, and Device editing. A complete list of menu
operations can be found at the end of this chapter.

9.1 Window Layout
The remainder of the Device Manager window is organized as follows:
DMX Output (Universe) Selection

Template
Library
Device Information
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9.2 Template Library
The Template Library area shows the collection of X1 Templates currently loaded on the PC running the
X1 application.

A Template can be thought of as a description of a Device. It determines how the Device will be
displayed in the X1’s Cue Editor, and it controls how the Device responds to crossfading, Grand Master
control, and etc.
Templates are organized in Folders. Typically folders are named for fixture and effect manufacturers.
The X1 also includes a selection of generic templates that consist of various numbers of fader or
switching channels. A folder is expanded by clicking on the small ‘+’ next to it.
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New Template Folders can be created by selecting ‘New Folder’ from the ‘Template’ menu. The folder
will be inserted into the library, and its name will be highlighted for renaming. Folders can also be
renamed later by clicking on them once to select them and then selecting ‘Rename’ from the Template
menu.
A Template Folder is selected by clicking on it once with the mouse. When a Template Folder is selected
a new Template can be created inside it by selecting ‘New Template’ from the ‘Template’ menu. Like
the folder, the new Template’s name will be highlighted for renaming immediately after being created.

As with folders, a Template can be renamed later by selecting it with a mouse click and then choosing
‘Rename’ from the ‘Template’ menu. When a Template is selected (highlighted), the two most common
operations are:
•
•

Use the Template to create a Device
Open the Template in the Template Editor

Device creation will be covered later in this chapter. The Template Editor is covered in its own chapter.

Deleting or modifying templates do not affect Devices already created.
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9.2.1 Template Storage on Disk
In order to exchange Templates with other X1 users or use the latest Templates available on
www.innovateshowcontrols.com it is important to understand how X1 templates are stored on disk. Each
X1 Template resides in a separate file on your PC’s hard disk. Each file has the extension ‘.tpl’.
Template Folders exist as regular folders on your hard disk.

By default, the X1’s templates will reside in a folder called ‘Templates’ which is placed by the X1
installer in the same location as the application BlueLiteX1.exe. This folder, and all sub folders, will be
searched for Templates each time the X1 application is started.
Important Note: Template folders cannot be nested. The X1 will only recognize one tier of subfolders
inside the main Template Folder.

Even if you create or download special templates to use in a show, you do not need to have those template
files installed in order to load and play the show on another X1 system. Everything needed to use a show file is
contained inside it.

9.3 DMX Output (Universe) Selection
Although the X1 has 16 DMX-512 universes (8192 channels total), only one universe and its associated
devices can be displayed by the Device Manager at a time. Universes are selected by clicking on the
associated tab at the top right portion of the window.
The software always displays all available universe, but universes with an associated hardware interface
are marked in green, those without are marked in red.
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9.4 Device Area
When a universe is selected, its 512 associated channels are shown on the bulk of the Device Manager
window. Any Devices that have been created are shown in yellow next to the channel(s) that they use.

New Devices are created by first selecting (highlighting) the Template you would like to base the Device
on and then clicking on the first channel in the universe that you would like the Device associated with.
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Multiple Devices based on the same Template can be created by dragging (clicking and holding down the
left mouse button) inside the Universe Device Area.

Devices will fill adjacent channels. Move the mouse so that shadows of Devices fill the channel areas
that you wish. When you release the left mouse button, the Devices will be created.

Devices are given default names based upon the template used to create them. These names can be
changed to something more meaningful by first highlighting the Device to be renamed by clicking on it
then selecting ‘Rename’ from ‘Device’ menu.
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Devices can also be deleted by selecting ‘Delete’ from the ‘Device’ menu. If a Device is currently
assigned to the wrong channels in the universe, it can be dragged to different channels using the mouse.

When you move a Device, any Cues that you have already created are preserved. Think of the Device
Manager as a virtual ‘patch bay’.

You can use <shift> click and <control> click to select multiple Devices.
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9.5 Menu Operations
File Menu
Entry
New Show
Open Show…
Save
Save As…
Close

Description
Create a new, empty show
Open an existing show
Save the currently open Show
Save the current show to a different file name
Close the Device Manager window

Template Menu
Entry
New Folder
New Template
Edit…
Rename
Delete

Description
Create a new Template Folder
Create a new Template inside the selected folder
Open the selected Template in the Template Editor
Rename the selected Template or Template Folder
Delete the selected Template or Template Folder

Device Menu
Entry
Rename
Delete

Description
Rename the selected Device
Delete the selected Device(s)

Tools Menu
Entry
Snapshot…
Live Panel…
ArtNet Output
Capture 3.0 (CITP) Interface
ArKaos (Artnet) Interface

Description
Capture the combined results off currently active Submasters
and XY Crossfaders to a single Cue
Launch the BlueLite Live Panel Application
Send all 16 universes over a LAN connection using the ArtNet
protocol
Establish a connection with LewLight’s Capture design
software
Establish a connection with ArKaos VJ DMX media software

Window Menu
Entry
Main Window…
Device Manager…
Cue List…
Event List…
Cue Editor…
Template Editor…

Description
Open the Main window
Open the Device Manager window
Open the Cue List window
Open the Event List window
Bring the Cue Editor to the front (if open)
Bring the Template Editor to the front (if open)
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10 Cue Editor

The X1’s Cue Editor is used to add Devices into a Cue and to adjust all Device settings for a particular Cue.
When the Cue Editor is opened, the designated Cue is normally assigned to an available X or Y Crossfader.
If the Crossfaders are being used to play an Event List, a warning will be given that the Cue is about to be
edited ‘blind’.
On the X1 it is important to remember the relationship of Cues, Devices, and actual DMX-512 channels.
Cue

Device 1

Channel

Channel

Device 2

Channel

Channel

Device 3

Channel

Channel

Channel

Device 4

Channel

Channel

Channel

Channel

DMX Channels

An X1 Cue is a collection of settings for Devices that have been specifically added to it. Devices are
virtually representations of the fixture (or fixtures) that they represent. They are created using an X1
Template that defines how the DMX-512 channel(s) should be treated and represented in the Cue Editor.
Devices are inserted in one of the X1’s 16 DMX-512 Universes at a specific channel. The relationships
between Cue and Device, and Device and DMX-512 channel are separate from one another. For example,
moving a Device to a different DMX-512 channel using the Device Manager does not affect the settings for
that Device in existing Cues.
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This abstraction between Devices and actual channels may seem unusual to users of certain modern
consoles but it not a particularly new lighting concept. Think of circuits and an old fashioned patch bay in a
theatre. A dimmer can be labeled ‘chair special’ and used to adjust a specific fixture without the operator
having to know the specific circuit number being used. The fixture can even be moved and placed on a
different circuit without having to change cues or dimmer labels.

10.1 Window Layout
The title bar of the Cue Editor always shows the Number and Name of the Cue being edited. Immediately
below the title bar is a menu for file operations, adding and removing devices to/from the Cue, and basic
Cue creation and duplication features. A complete list of menu operations can be found at the end of this
chapter.
The Remainder of the Cue Editor window is divided as follows:

Device List

Device Settings Area

10.2 Device List
The Device List shows which device or devices have been added to the Cue currently being edited.
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The list can contain a single Device or every Device in the show. Devices can also be of any type (created
from any Template).
Devices are added to this list by selecting ‘Add/Remove’ from the ‘Device’ menu.

Devices are added by selecting them on the left hand side of the Add/Remove Devices Dialog and selecting
the Add button. Devices are removed by selecting them in the right hand side of the dialog and pressing the
Remove button. Devices can be added to and removed from a Cue at any time.

You can also add and remove Devices by ‘double clicking’ on the name. Double click on “DMX Devices” at the
top of the list to add or remove all devices.
In addition to showing what Devices have been added to the current Cue, the Device List is where Devices
are selected for viewing and editing in the Device Settings Area. Selections are made with mouse clicks,
<shift>mouse clicks and <ctrl>mouse clicks.
Important Note: If Devices are removed from a Cue, all cue data for those Devices will be lost.
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If Devices are created from the same Template, they can be simultaneously selected for editing on the X1.

10.3 Device Settings Area
The Device Settings Area is where settings for a Device (or Devices) for the Cue being edited can be
viewed and changed.

The appearance of this area depends upon the Template used to create the Device (or Devices) currently
selected. Controls in the Device Settings Area can be directly adjusted with the mouse. In the alternative,
focus can move between the Device List and the various controls in the Device Settings Area using <tab>
and <shift><tab>.
When a Control has focus, it is outlined in a light blue color.

When a Control has focus, it can be adjusted using the keyboard. The exact behavior depends upon the type
of control, but most controls respond to the arrow keys and <PageUp>/<PageDown> keys, as well as the
<Home> and <End> keys where applicable.
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Changes made in the Device Settings Area are immediate. In other words, no additional user input is
required for the changes to be saved or viewed on the stage.

If you want to experiment with changes to an existing Cue, consider using the ‘Duplicate…’ feature under the
‘Cue’ menu to copy the existing cue to a new Cue Number first.

10.4 Device Settings
All Templates are made up of some combination of the following four basic controls:
•
•
•
•

Fader Control
Position Control
Combo Box Control
Mode Control

10.4.1

Fader Controls

Fader Controls are basic sliders. They are adjusted in essentially the same way as faders on the Main
(‘Console’) window. See Section 4.2 in this manual for details.
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10.4.2

Position Controls

Position Controls are intended for simultaneously adjusting Pan and Tilt options on a fixture. With the
screen area of the Position Control, pan and tilt can be set in several ways.

The location marker can be dragged using the mouse by holding down the left mouse button. Alternately,
the marker can be set immediately to a location by clicking there. If the mouse has a scroll wheel it can be
used to adjust pan (<Control>scroll) and tilt (scroll) once the control is selected Clicking the scroll wheel
button (if available) toggles ‘tracking’ mode on and off. Current pan and tilt settings are displayed at the
bottom of the screen area. Position can also be adjusted using the buttons around the perimeter of the
screen. Clicking on a button makes the smallest possible change in the direction indicated. Click and hold
the left button if you would like to make larger changes.
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Every Position Control automatically is given an Effect Generator. Effects are selected using the Combo
Box immediately above the screen area.

Once an effect shape is selected, the speed, size, rotation, and scan direction can be adjusted with the Effect
Controls to the right of the screen.

Important notes about Effects:
•

Every position control has its own built in Effect Generator. This means that every fixture can be
set to its own shape, direction, speed, gain, and rotation.

•

When an effect generator transitions from off (no effect) to on (a selected shape) it begins drawing
the shape from the beginning. So, if you want to ‘synchronize’ the effects generators in multiple
fixtures, transition from a cue where all the effects generators to be synchronized are off to a cue
that has the shapes and speeds, etc. that you desire.

•

Effect shapes clip when they hit the limit on the Position Control (max pan or tilt value for the
fixture).

•

Effect shapes can be crossfaded. That is, an Arc will slowly morph into a Circle and so on.

Because of the motor speed on some fixtures, and the limited update rate of the DMX-512 standard, effects
may appear a bit ‘jerky’ on some fixtures at some settings. If the fixture has a motor speed control, slowing it slightly
can often smooth this out.
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10.4.3

Combo Box Controls

Combo Box Controls are used to adjust settings that cannot be faded and are similar to Combo Boxes used
in normal Windows Applications.

Selections can be made from a list by selecting the drop-down arrow on the right side of the control. Unlike
a typical Combo Box, available selections can also be scrolled through using the increment and decrement
arrows on the left side of the Control.

10.4.4

Mode Controls

Mode Controls are typically used either when a single DMX-512 channel is used for multiple functions, or
when the level of one DMX-512 channel alters the behavior of others on the same fixture. They are similar
to the Tabs used on Windows dialog boxes. Selections are made by clicking on the desired tab.
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10.5 Simultaneously Editing Multiple Devices
As noted previously, Devices in a Cue that were created using the same Template can be concurrently
selected in the Device List and edited in the Device Settings Area.

The settings for all selected devices simultaneously displayed.
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Multiple, differing settings gives the user two options for making changes:
•
•

Absolute adjustments
Relative adjustments

Absolute adjustments change the setting for a particular control to the same value for all selected Devices.
Relative adjustments change the settings for a control relative to the current setting for each of the selected
Devices.
Absolute adjustments are generally made with the main portion of a given control. For example, grabbing
the knob or ‘thumb’ on a fader, using the screen area of a position control, or the drop down arrow on a
Combo Box will set all the selected fixtures to the same value.

Relative adjustments are made using the arrows on each control. This will adjust the setting on each Device
relative to its current setting.

Combining ‘Duplicate’ with Relative adjustments is a great way to quickly create new looks.
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10.6 Menu Operations
File Menu
Entry
New Show
Open Show…
Save
Save As…
Close

Description
Create a new, empty show
Open an existing show
Save the currently open Show
Save the current show to a different file name
Close the Cue Editor window

Device Menu
Entry
Add/Remove…

Description
Add or Remove Devices in the Cue

Cue Menu
Entry
Next
Previous
Goto…
Insert…
Duplicate…

Description
Display/Edit the next Cue
Display/Edit the previous Cue
Display/Edit a specified Cue
Insert a new Cue into the show
Duplicate the current Cue to a new Cue Number

Tools Menu
Entry
Snapshot…
Live Panel…
ArtNet Output
Capture 3.0 (CITP) Interface
ArKaos (Artnet) Interface

Description
Capture the combined results off currently active Submasters
and XY Crossfaders to a single Cue
Launch the BlueLite Live Panel Application
Send all 16 universes over a LAN connection using the ArtNet
protocol
Establish a connection with LewLight’s Capture design
software
Establish a connection with ArKaos VJ DMX media software

Window Menu
Entry
Main Window…
Device Manager…
Cue List…
Event List…
Cue Editor…
Template Editor…

Description
Open the Main window
Open the Device Manager window
Open the Cue List window
Open the Event List window
Bring the Cue Editor to the front (if open)
Bring the Template Editor to the front (if open)
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Intentionally Left Blank…
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11 Template Editor

Templates serve two important purposes on the X1. Templates control how Devices are displayed in the
Cue Editor (covered in the previous chapter) and how crossfades, Grand Master input, etc. are handled.
The X1 does come with a large selection of pre-made Templates and additional templates can be
downloaded from www.innovateshowcontrols.com. Unfortunately, the sheer number of existing fixtures,
not to mention the constant introduction of new fixtures, makes it impossible for Innovate Show Controls
to directly support all of them. Therefore, the X1’s Template Editor allows users to create their own
templates. User created templates are identical to Innovate Show Controls provided templates. The one
exception being that no Certification watermark will appear in the lower right corner when the Template
is viewed in the Template Editor.

Companies and individuals wishing to watermark their own Certified Templates can send email to
support@innovateshowcontrols.com and request a Vendor ID and Watermark tool.

11.1 Window Layout
The title bar of the Template Editor indicates the name of the Template currently being edited.
Immediately below the title bar is a menu bar for file operations and editing inserted controls. A
complete list of menu operations can be found at the end of this chapter.

11-1

The remainder of the Template Editor window is laid out as follows:

Control
Toolbar

Template Edit Area

11.2 Control Toolbar
The Control Toolbar has selections for each of the four types of controls that can be inserted into a
template.

•
•
•
•

Fader Controls are use for basic sliders or faders
Position Controls are used for Pan/Tilt Channels and automatically include an Effects Generator
Combo Box Controls are used for non-fading channels
Mode Controls are for cases where multiple functions are combined on one channel or where the
affect of multiple channels is interrelated

Select the arrow at the top of the toolbar to manipulate an existing control instead of inserting a new one.
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11.3 Template Edit Area
Once a Control has been selected on the Control Toolbar, a Control of that type can be inserted into the
template by clicking in the Template Edit Area.

Inserted Controls can be selected for editing using the arrow from the Control Toolbar. Selected Controls
are indicated with small adjustment boxes around it. A Control’s position can be adjusted by clicking and
dragging on the face of the Control. The size of a Control can be adjusted by dragging on the adjustment
boxes around it.

You can insert and/or resize the Control in one operation by holding down the mouse button while inserting
the Control.

When a control is selected in the Template Editor, you can adjust its location using the arrow keys and its
size using the <shift>arrow keys.
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11.4 Control Properties
Once a Control is inserted into a Template its properties must be configured. To do so, first select the
Control by clicking on it, then select ‘Properties…’ from the ‘Edit’ menu. All Controls have a Name
property, which is a label that appears above the control in the Cue Editor.

Double clicking on a Control also open the Properties dialog box.

All Controls also contain one or more Channel Offset properties. Channel Offset determines what DMX512 channel or channels will be affected by a Control when a Device is created from a particular
template.
Offsets are used because Templates can be used to create devices anywhere in the X1’s 16 DMX-512
universes. Offsets are relative to the insertion point for a device, making the formula to convert Offset to
physical channel:
Device Insertion Base Channel + Offset = Device Channel
In other words, 0 indicates the first channel in a device, 1 the second channel and so on. Controls have
additional properties, but they vary based upon Control Type. These Control specific properties are
described in the following sections.

11-4

11.4.1

Fader Control Properties

Name
As with all controls, this is the optional label that will be displayed above the control in the Cue Editor.
Grand Master Controlled
This checkbox determines if a fader is affected by the X1’s Grand Master. For conventional lighting this
checkbox would normally be selected. For a complex moving fixture, this checkbox would normally only
be selected for the fader used for the dimming channel.
Number of DMX Channels
Fader Controls can be used for 8 bit control (one DMX-512 channel) or 16 bit control (two DMX-512
channels). Selecting a mode determines if one or two Channel Offset fields are enabled.
Channel Offset
This determines which DMX-512 channel(s), based upon offset from the Device Insertion Point, the Fader
Control will affect. See the Section 11.4 for more information.
Minimum and Maximum DMX Values
These properties set the range of values used by a Fader Control. This range can be all available DMX512 values or a subset. Subsets are particularly useful when a manufacturer has put multiple modes or
functions on the same DMX-512 channel. A Mode Control can first be used to divide the channel up into
its different functions then Fader Controls configured for the appropriate range can be placed on the
different Mode Control pages.
Reverse Fader
Selecting this checkbox causes the Fader to operate in reverse. That is, the fader full on represents the
Minimum Value and the fader off represents the Maximum Value. This can be useful when creating
templates for fixtures with inverted operations (ex. off = fastest) in their DMX-512 protocol.
The Minimum and Maximum DMX Values should be used the same way whether Reverse Fader is selected
or not selected.
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11.4.2

Position Control Properties

Name
As with all controls, this is the optional label that will be displayed above the Control in the Cue Editor.
Number of DMX Channels
Position Controls can be used for 8 bit control (one DMX-512 channel for pan and one for tilt) or 16 bit
control (two DMX-512 channels for each axis). Selecting a mode determines if two or four Channel
Offset fields are enabled.
Channel Offsets
This determines which DMX-512 channels, based upon offset from the Device Insertion Point, the
Position Control will affect. See the Section 11.4 for more information.
Important Note: Some manufacturers refer to Coarse Channel as the ‘Hi-Byte’ and the Fine Channel as
the ‘Lo-Byte’.
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11.4.3

Combo Box Control Properties

Name
As with all controls, this is the optional label that will be displayed above the Control in the Cue Editor.
Channel Offset
This determines which DMX-512 channel, based upon offset from the Device Insertion Point, the Combo
Box Control will affect. See the Section 11.4 for more information.
Value and Description Table
This table determines what options will be presented in the Combo Box when it is visible in the Cue
Editor. Value is the numeric value that will be placed in the DMX-512 channel specified by the Channel
Offset Property. Description is the text that will be presented in the Combo box to the user.

DMX Values can also be entered in Control property dialogs as either an absolute value (ex. “64”) or as a
percentage (ex. “25%”).

Most fixtures give ranges for select values. You can pick any value in that range in order for the Combo
Box Control to work.
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11.4.4

Mode Control Properties

Name
As with all controls, this is the optional label that will be displayed above the control in the Cue Editor.
Active Mode
A Mode Control can behave in one of two ways. It can be Active or Passive. Active behavior can be
selected using this checkbox. Active behavior is similar to a Combo Box Control. Selecting a specific
Mode Control Page will set a specific value in the DMX-512 channel specified using the Mode Control’s
Channel Offset property. Once the value is set, the Mode Control Page then calls the Controls that are
contained in it. These controls are typically configured to adjust other channels. Active Mode is
primarily intended for situations where setting a value on one DMX-512 channel affects the behavior of
other channels on a fixture.

Mode Page
Control

1) Sets 'mode'
channel to
specific value

related channel
Control

'mode' channel
Control

related channel

related channel

'Active' Mode Control
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When Active behavior is not selected, Mode Controls behave passively. Instead of actively setting the
DMX-512 channel specified in the Channel Offset property, the designated channel is monitored and the
active Page selected based upon value ranges. This behavior is intended for cases where a single DMX512 channel is used for multiple functions. The Mode Control passively determines what function is in
use (ex. forward spin, random, indexed color, etc.) and then selected the associated page. The Controls
contained in the page are then responsible for setting the channel (or channels) to a suitable value.

1) Mode Control
Monitors Channel
Value

Mode Control
Mode Page

multi-purpose
channel
Control

3) Page calls
control contained
in it

4) Control sets
channel to valid
value

'Passive' Mode Control

Mode Controls configured as passive depend upon the Controls contained in their Pages to do the actual
setting of values. That is why some stock X1 Templates have Mode pages with Combo Boxes that have only a
single value (ex. “None”, “Open”, or “White”).
Channel Offset
This determines which DMX-512 channel, based upon offset from the Device Insertion Point, the Mode
Control will either affect or monitor. See the Section 11.4 for more information.
Text/Value/Range Table
This table defines how many Pages (Tabs) will be displayed for the Mode Control. When a Mode control
is configured as Active, the Mode Channel Value column is enabled and should be configured with values
to set in the associated DMX-512 channel. When a Mode control is Passive (Active not selected), the
Mode Channel Value column will be disabled and the channel range for each page should be defined
using the Range Low and Range High columns.

You cannot nest Mode Controls. If you are sure you need to do this, then whoever created the DMX-512
protocol for the fixture you are trying to control should be beaten with a stick. Email me at steve@bluelitex1.com and
I will take care of it.
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11.5 Menu Operations
File Menu
Entry
Save
Save As…
Close

Description
Save the current template
Save the current template to a different name
Close the Template Editor window

Edit Menu
Entry
Delete
Select All
Properties…

Description
Delete the currently selected control(s)
Select all controls
Display properties for the currently selected control

Window Menu
Entry
Main Window…
Device Manager…
Cue List…
Event List…
Cue Editor…
Template Editor…

Description
Open the Main window
Open the Device Manager window
Open the Cue List window
Open the Event List window
Bring the Cue Editor to the front (if open)
Bring the Template Editor to the front (if open)
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12 LivePanel

The LivePanel is a companion application for the BlueLite X1. It utilizes the the BlueLite X1’s
Automation API (see the appendix in this manual). It is intended for situations where rapid recall of Cues
and Cue sequences in an unplanned order is required.
Although it is a separate application, it is tightly integrated with the main X1 application. For example,
LivePanel settings are saved in the same file as X1 show data.

12.1 Screen Layout
The LivePanel User Interface is ‘Skinnable’. That is, you can select different appearances using the Skin
button and download new, specialized skins (Touch Panel, MIDI control, etc.) from
www.innovateshowcontrols.com. You can even design your own skin. However the default skin is laid
out as follows:
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Toggles

Sequence Recall

Config

Crossfaders

Grand
Master

Chasers

Random

The default LivePanel Skin is keystroke based and all shortcut keys are displayed and underlined.
Important Note: For an introduction to LivePanel usage, please see the Quick Start tutorial earlier in
this manual.

12.2 Chasers
The core building block of the LivePanel is a ‘Chaser’. A chaser is selected either by clicking on it, or
pressing the corresponding number key (‘1’ for chase 1, etc.). One or more Cues is assigned to a chaser
with the ‘Cues…’ button.
The cue sequence can be manually advanced using the ‘Step’ button (‘T’
key) or automatically sequenced using the Transport buttons. ‘F’ for
forward, ‘R’ for reverse, and ‘B’ for bally (back and forth).
The speed of sequencing is controlled by the right hand fader. ‘+’ for
faster, ‘-‘ for slower, ‘]’ for full speed (1/25 a second), and ‘[‘ for slowest
(10 seconds). Speed can also be set by clicking on the ‘Tap’ button
(spacebar).
The level a cue is displayed at is controlled by the left hand fader. Up
arrow for higher, down arrow for lower, pageup for full (100%), pagedown
for off (0%).
Turning ‘Fade’ on and off (‘A’ key) determines if the chaser will step
between cues, or gradually fade based on the current speed.
Turning ‘Once’ on and off (‘E’ key) determines if a sequence will repeat,
or just play to the end (or beginning).
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12.3 Crossfaders
By default, the LivePanel’s four chasers are combined into two pairs of two, with crossfade controls to set
the respective levels of each chaser.

The level of each chaser is displayed just above the chaser and just below the crossfade controls. To
simultaneously use both chasers, select Disable (‘D’ key) by the crossfade controls (default).

To generate smooth fades and crossfades, use <ctrl>, <alt>, and <shift> to modify the crossfade, level,
speed, and grand master shortcut keys.

The ‘Tap’ button (or <spacebar>) is an easy way to set a chaser’s speed.
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12.4 Sequence Save/Recall
Chase settings can be saved and assigned to variations of the Function Keys (ex. <F1>, <alt><F1>, etc.)
by selected the Save button (‘V’ key) in the middle of the screen.
Save settings are called a ‘Sequence’.
Sequences can be given a name and assigned a
bitmap (both optional).
A sequence can also contain all, or just a
portion of the current chase settings. For
example, Function keys can be created that
just represent sequences of cues, speed
changes, and so on.
The ‘Chaser’ option determines if a recall will
always place the sequence back in the chaser it
was saved from (1 through 4), or if it will be
recalled into the currently active chaser.
One the name, graphic, and desired settings are selected, users are prompted to enter the Function key
combination they would like the sequence associated with.

Basic function keys (F1-F12) and basic modifiers (none, <shift>, <ctrl>, and <alt>) provide 48 save
location. A collection of 48 saved sequences is called a page.

LivePanel offers 24 pages of 48 saved sequences each (selected using the page buttons and controls at the
top of the screen) for over 1,000 saved sequences in a single X1 show file.
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12.5 Grand Master
For convenience the LivePanel offers direct control over the X1 Grand Master.
Letting Cues be faded up or faded to black without having to toggle between
screens.
Like the crossfade controls, speed controls, and level controls, the Grand Master
shortcuts respond to ‘autofade modifiers’. For example, <alt><del> will fade the
Grand Master to black in 3 seconds and <ctrl><ins> will fade the Grand Master to
full in 1 second.

12.6 Random
The Live Panel also has a Random Function. It can be assigned to a give
Recall row.
When active, it will randomly select from used save locations in that row
at a random rate (which can be roughly controlled using the level buttons
on the right).
Pressing the Step button (‘P’ key) forces an immediate random selection
from the selected row.

12.7 Toggles
The LivePanel also has 4 ‘Toggle’ buttons for activating individual Cues. This is
convenenient for things like smoke machines and strobe lights. You assign cues to the
buttons using the Assign button below the buttons. Assigned cues are displayed on the
buttons, the shortcut keys to activate the buttons are shown to the left.
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12.8 External BPM Sources
The LivePanel allows chasers to be locked to external ‘beat’ or BPM sources. External sources are
accessed via special ‘plug-in’ modules. To activate a BPM plug-in (ex. the Audio Input plug-in provided)
select the ‘Config’ button.
To lock a chaser to the active source, click on the ‘BPM LOCK’ checkbox below the chaser. Note, BPM
LOCK state is saved with ‘Speed’ in sequences.

12.9 MIDI Input
The LivePanel has build in support for MIDI input. An
external MIDI controller can be used to activate all of the
functions normally available in the default skin. In addition,
controllers can be used to directly set Levels, Speeds, and
Crossfaders.
To turn on MIDI support, select the ‘Config’ button. The
MIDI Setup dialog allows you to specify a MIDI input to
monitor, a MIDI map to use (see Appendix for details) and a
MIDI channel to use for the map on the selected input.

12.10 Additional Notes
Each LivePanel chaser automates an X1 XY Crossfader Pair. Chaser 1 uses XY pair 4, Chaser 2, uses
XY pair 3, Chaser 3 uses XY pair 2, and Chaser 4 uses XY pair 1. The reason that the chasers use the XY
faders in reverse order is that this permits several Event Lists and Chasers to be used together. For
example Chaser 1 and 2 and Event List 1 and 2 could all be run simultaneously without an XY Crossfader
conflict.
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13 Template Creation Tutorial
If you have already worked through the simple Template tutorial at the end of Chapter 4 and read Chapter
11 on the Template Editor then you should already have a pretty good understanding of Template basics.
This tutorial is intended to build on that understanding by walking you through the partial construction of
a far more complicated template.
The new Template will include both active and passive Mode Controls. It will also be based on a real
fixture, the High End Systems Technobeam.

13.1 Getting Started
First you will want to obtain whatever documentation is available for the fixture you intend to control.
Although it is not absolutely necessary, it may be helpful to download the Technobeam User’s Manual
from www.highend.com and refer to it during the remainder of this tutorial.
The Technobeam, like many fixtures, offers multiple DMX-512 interface options. When creating your
own Templates you should be careful to select an operating mode for a fixture that offers all of the
features you need. For this tutorial, we will focus on the Technobeam ‘Full’ or ‘TB-F’ protocol. This
protocol uses 18 channels and is quite complicated. In cases like this generating a complete Template
directly from documentation alone can be quite daunting. One technique you may find helpful is to start
with a generic Template and then customize it a few channels at a time. This is the approach we will use
for this tutorial.
Begin by opening the Console 24 Template in the Generic folder in the Template Editor.
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Delete the last six faders (19-24) by highlighting the faders and pressing the <Del> key, or by selecting
‘Delete’ from the ‘Edit’ menu.

Now, select ‘Save As…’ from the ‘File’ menu and save the modified Template as ‘My Techno’.
This Template can now be used to create a Device. The Device, in turn, can be placed in a Cue. Editing
the Cue can give you a much better understanding of the fixture’s capabilities and protocol.

13.2 Some Easy Stuff
Examining the Technobeam documentation and experimenting with a Device created from the ‘My
Techno’ Template quickly reveals that some Technobeam features are easy to customize. The most
obvious improvement to the Template would be the addition of a Position Control.
If necessary, re-open the ‘My Techno’ Template created above in the Template Editor. Select and Delete
the first four faders (1-4). Move the remaining faders to clear additional space in the upper left corner of
the Template Edit Area.

The arrow on the toolbar allows you to click and drag to select multiple Controls. These Controls than can
be simultaneously moved, either by dragging them with the mouse or by using the arrow keys on the keyboard.

Holding down the <ctrl> key while clicking on Controls will select/unselect them.
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Insert a Position Control and set its properties so that it controls the first four channels in the Template
(Offset 0-3).

This change has two immediate benefits. All four position channels can now be simultaneously adjusted.
In addition, there is now an Effects Generator at your disposal when creating Cues.
Three additional channels are easily configured as well. Open the properties dialog for fader 15. Change
the Name from ‘15’ to ‘Dimmer’ and close the dialog.
Open the properties for fader 13 and rename it to ‘Focus’. Disable the Grand Master Controlled checkbox
before closing the dialog.
Finally, adjust the properties for fader 16. It should be renamed ‘MSpeed’ and Grand Master control
should also be disabled.
Now that the controls have been modifying, re-arrange all the faders on the Template so that the modified
faders are clustered together. You can also resize the faders if you wish. Now would also be a good time
to save and retest the Template.

Although you can resize, reconfigure, and re-arrange Controls, tab order, the order that <tab> and
<shift><tab> keystrokes cycle Control focus in the Cue Editor is based upon the order in which Controls are inserted
into a Template. So, if you frequently use the keyboard, or if you intend to distribute a Template to other users, you
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should consider deleting existing controls and inserting new ones so that focus will not move erratically in the Cue
Editor.

Important Note: Editing a Template does not alter Devices that were previously created from it. If you
would like to change the Template used by a fixture, it is necessary to first delete the existing Device then
create a new one from the Template to be used or tested.

13.3 A Passive Mode Control
Now that you have greatly enhanced your Technobeam template with a few simple changes it is time to
tackle a more complicated channel. The Technobeam uses a single DMX-512 channel (14) to provide six
different shutter related features:
Function
Closed
Strobe
Random
Ramp Open
Ramp Closed
Open

Description
The shutter is closed
The shutter ‘strobes’ at a variable rate
The shutter flashes randomly at a variable rate
The shutter ramps open at a variable speed, then ‘snaps’ closed
The shutter ‘snaps’ open then ramps closed at a variable speed
The shutter is open

As you have already read, Mode Controls are primarily intended to be used in two situations:
•
•

The settings on one channel affect the purpose or behavior of other channels
A channel is used for multiple purposes
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The Technobeam’s shutter channel is a case of the latter. Mode Controls of this type are called passive
Mode Controls.
Insert a Mode Control into your Technobeam Template and adjust its properties as follows:

This places the label Shutter on the Mode Control, makes it passive, and associates it with channel 14
(Offset 13). There are six tabs, each one representing a function provided by the channel. Each page is
also set to match a range of values on the DMX channel. The values associated with each function are
listed in the Technobeam documentation.

It is not required, but it is generally a good idea for passive Mode Controls to create ranges which cover all
possible DMX-512 channel values.
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After closing the property dialog adjust the size and position of the Mode Control so that it has room for
controls to be placed inside it.

Important Note: Remember that a passive Mode Control does not alter its associated DMX-512
channel. This means that every page on a passive Mode Control must contain a control associated with
the same Offset Channel which is configured to adjust the channel within the valid range for the page.
Add a Combo Box Control to the ‘Closed’ page and set its properties as follows:

Since there is only one Value/Description pair, this control will always force channel 14 (Offset 13) to 0
when the ‘Closed’ page is selected.
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Select the ‘Open’ page and insert a Combo Box Control for channel 14 (Offset 13) with a single
Value/Description pair of ‘255’ ‘Open’. This will force the channel to 255 whenever the ‘Open’ page is
selected.
Important Note: Most users would find it preferable if Open and Closed were offered in the same
Combo Box Control. Many DMX-512 protocols permit this, but the Technobeam TB-F protocol does
not. That is because shutter open and close operations are not provided in a contiguous range of values.
Other functions, such as Random, are in between.
The Technobeam’s shutter strobe feature can be varied in speed. To provide this in the Template, select
the ‘Strobe’ page and insert a Fader Control. Set the Control’s properties as follows:

This provides a speed control which will adjust channel 14 (Offset 13) to a value between 8 and 67 (the
range specified in the Technobeam protocol for shutter strobe). It will not be affected by the Grand
Master.
Add Fader Controls for speed to the ‘Random’, ‘Ramp Open’, and ‘Ramp Closed’ pages as well. The
properties should be similar to the ones above, but the Minimum and Maximum DMX Value properties
should be set to match the range of the page that the Fader is placed in.
Finish up by deleting the original fader 14 from the Template and saving it. You now have a template
that not only lets you pick shutter functions quickly by name, it intelligently transitions between different
shutter functions when Cues are crossfaded or blended together using Submasters.

13.4 An Active Mode Control
If you thought that the Technobeam’s shutter control was complicated, wait until you get a load of its
Litho Wheel features. Four DMX-512 channels are used (7-10). Channel 7 sets Litho Wheel mode. The
remaining channels perform different functions depending upon the mode selected.
You will be using an active Mode Control for channel 7 (Offset 6) and inserting controls in each page to
manage channels 8-10. The Technobeam offers ten different Litho Wheel Modes, but five of them are
basically repeats, the only difference being that the Motor Speed channel is added into the mix. Since
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‘Continuous’ mode, combined with crossfading can achieve very similar looks, this tutorial will omit the
Motor Speed affected repeats.
The five remaining modes will be represented on six tabs. The reason for the extra tab is that one Litho
Wheel mode, wheel spin, uses a single channel for controlling direction and speed. Low speed is in the
middle of the channel’s range and maximum speed in each direction is represented by the ends of the
channel’s range (0 and 255). Channels of this type fade badly when placed on a Submaster, so you will
be splitting this Litho Wheel mode in two.
Insert a Mode Control into your Technobeam Template and set its properties as follows:

This will create an active Mode Control which directly controls channel 7 (Offset 6). Selecting a page
directly sets a specific value into this channel before invoking the controls contained in it.
Each Mode Page will need appropriate Controls to adjust channels 8-10. Indexed mode uses channel 8 to
select a Litho Wheel position, and channels 9 and 10 as a 16 bit (2 DMX-512 channels) rotation control
for the selected Litho.
Insert a Combo Box Control and a Fader Control in the ‘Indexed’ Page and set their properties as follows:
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Whenever Indexed mode is selecting using the ‘Indexed’ tab, channel 8 (Offset 7) can be set with a
Combo Box and channels 9 and 10 adjusted with a single 16 bit fader.

The Technobeam’s Blink mode is identical to the Indexed mode. The only difference is that the lamp is
shuttered during Litho Wheel moves. So, the remaining channels (8-10) can be controlled the same way.
Insert a Combo Box Control and a Fader Control into the ‘Blink’ page and set their properties the same
way as the Controls on the ‘Indexed’ page.
The Technobeam’s Litho Wheel Scan mode lets users select a Litho Wheel position and scan, or jiggle, it
at a variable speed. So, again, you will need to insert a Combo Box Control and a Fader Control on the
‘Scan’ page.
The Combo Box properties should be set to match the Combo Box Controls that were used in the
‘Indexed’ and ‘Blink’ pages. However, the Fader Control should be set as follows:
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The name has been changed to match the fader’s function for this Litho Wheel mode. Also, Scan mode
does not use channel 10, so the fader has been configured to adjust only channel 9 (Offset 8).
In Litho Wheel Random mode, channels 8 and 10 are ignored. Wheel positions are selected randomly,
and speed is controlled by channel 9. So, insert a Fader Control in the ‘Random’ page and configure it to
match the fader control used for speed on the ‘Scan’ page.
The Litho Wheel Spin mode also ignores channels 8 and 10, so the ‘Fwd Spin’ and ‘Rev Spin’ pages will
also need just one Fader Control for adjusting speed as well. However, since you are splitting the
Technobeam’s built in mode in half, the properties for each dialog will need to be slightly different.
The Fader Control on the ‘Fwd Spin’ page should be set as follows:

Like the speed controls on the other pages, this Control is not Grand Master affected. It is also associated
with channel 9 (Offset 8). However, it only uses half the available values on the channel, and it is
Reversed. This is so Fwd Spin speeds will fade and crossfade more intuitively.
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The Fader Control on the ‘Rev Spin’ page should be set like this:

Notice that these settings are very similar. The differences are that this fader is not reversed (since 255 is
the fastest reverse spin speed on the Technobeam) and the Minimum and Maximum DMX Value
properties are set to the channel values not used by the ‘Fwd Spin’ Fader Control.
Once you delete the original faders (7-10) and saved you will have exposed two complicated feature sets
using Mode Controls. This not only makes Shutter and Litho Wheel Cues easier to program, it makes
Cues transition more seamlessly.
That just leaves Color Wheel control, Effects Control, Fixture Control, and Laser Aiming Device Control
(if installed)…. Consider those your homework.

You can examine stock Templates and Templates from other users with the Template Editor to get ideas on
how to represent DMX-512 protocol features in your own Templates.

13.5 Additional Template Tips
•

Whenever possible, construct your Templates so that all channels can be set to 0 in a cue.

This allows users to create ‘mix and match’ cues for use on the Submasters during live shows. For
example, cues can be created with fixtures at various positions (pan/tilt settings), but all other channels at
0. Likewise, cues can be created with different color, gobo, and effect settings, but position (pan/tilt) set
at 0. Position Cues can then be mixed with color/effect Cues using Submasters to rapidly create many
looks with just a relatively small number of faders.
•

Certified Templates, like the stock Templates included with the X1, cannot be accidentally
overwritten.

13-17

Because stock templates are not easily corrupted, users should not hesitate to modify them and the use
‘Save As…’ from the ‘File’ menu to create their own even if the changes are as simple as new names for
the faders in a Generic Console.
•

Mode Controls are powerful, but still have limitations.

Many first time Template creators get pre-occupied with the final look and feel of their Templates. They
get frustrated when Controls, most notably Mode Controls, do not let them present all fixture features
exactly as they desire. This is understandable. However, it is a misunderstanding of the strengths and
capabilities of Mode Controls.
The Mode Control is not primarily intended to be a User Interface Tool, but a functional one. It was
designed to do one of two jobs: splitting a multi-function control channel on a fixture into separate pages;
or setting a ‘mode’ channel on a fixture and then presenting suitable controls for the other channels
affected by it. In both cases, the Mode Control not only presents options in the Cue Editor, it enables the
X1 to transition smoothly between different modes during Cue changes as well.
•

Mode Controls cannot be nested.

This limitation is by design. There are no plans to remove it in future versions at this time.
•

Users are encourage to share Templates

Because of the sheer number of DMX fixtures available, it is impossible for Innovate Show Controls to
provide stock Templates for all of them. Generic Templates can often be used, but specialized Templates
are typically easier to use and behave more appropriately when Cues are mixed, matched, and faded using
Submasters. You can share your Templates, as well as download other user’s Templates at
www.innovateshowcontrols.com.
•

You can certify your Templates

If you are a fixture manufacturer and would like to see certain features of your product(s) exposed a
specific way on the X1, or if you are simply an individual with too much time on your hands, you can
become a Certified Template developer. Contact us at support@innovateshowcontrols.com for more
details.
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Appendix A – DMX-512 Input Protocol
The X1 can respond to up to 47 channels of DMX-512 input for control. Control is broken down into
several sections, each of which can be enabled and disabled individually. The channel breakdowns for all
sections are shown in the table below.
Submasters
Channel
1-24

Value
0-255

Description
Proportional – Adjust X1 Submaster Level

Load Presets
Channel
25

Value
0-9
10-19
20-29
30-39
40-49
50-59
60-69
70-79
80-89
90-99
100-109
110-119
120-129
130-139
140-149
150-159
160-169
170-179
180-189
190-199
200-209
210-219
220-229
230-239
240-255

Step
Step
Step
Step
Step
Step
Step
Step
Step
Step
Step
Step
Step
Step
Step
Step
Step
Step
Step
Step
Step
Step
Step
Step
Step

–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

Description
No Action
Load Preset 1
Load Preset 2
Load Preset 3
Load Preset 4
Load Preset 5
Load Preset 6
Load Preset 7
Load Preset 8
Load Preset 9
Load Preset 10
Load Preset 11
Load Preset 12
Load Preset 13
Load Preset 14
Load Preset 15
Load Preset 16
Load Preset 17
Load Preset 18
Load Preset 19
Load Preset 20
Load Preset 21
Load Preset 22
Load Preset 23
Load Preset 24

Grandmaster
Channel
26

Value
0-255

Description
Proportional – Adjust X1 Grandmaster Level

XY Crossfaders
Channel
27
28
29
30
31
32

Value
0-255
0-255
0-255
0-255
0-255
0-255

Proportional
Proportional
Proportional
Proportional
Proportional
Proportional

–
–
–
–
–
–

Description
XY Crossfader Pair 1
Y Gain 1
XY Crossfader Pair 2
Y Gain 2
XY Crossfader Pair 3
Y Gain 3
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33
34

0-255
0-255

Proportional – XY Crossfader Pair 4
Proportional – Y Gain 4

Note: “Pair” channels simultaneously control the X1 X and Y faders. 255 = X 100%, Y 0%. 0 = X 0%,
Y 100%. “Gain” channels gain, or scale, the associated Y fader only. This arrangement allows balanced
crossfades to be made from non linear consoles while still allowing the XY channels to be used as extra
(non simultaneous) ‘Submasters’ for live shows.
Transport Controls
Channel
35
36
37
38

Value
0-127
128-255
0-127
128-255
0-127
128-255
0-63
64-127
128-191
192-255

Step
Step
Step
Step
Step
Step
Step
Step
Step
Step

–
–
–
–
–
–
–
–
–
–

Description
No Action
‘Press’ X1 Play Button
No Action
‘Press’ X1 Stop Button
No Action
‘Press’ X1 Record Button
No Action
Select X1 Internal Mode
Select X1 Timecode Mode
Select X1 Step Mode

Note: Channel 38 is ignored when the X1 is already in Play or Record mode.
Automation
Channel
39

Value
0-127
128-255

40
41
42
43
44
45
46
47

0-255
0-255
0-255
0-255
0-255
0-255
0-255
0-255

Description
Step – No Action
Step – Play the event list section
specified in channels 40-47 in Internal
Mode.
Step – Start Time ‘Hours’ times 4
Step – Start Time ‘Minutes’ times 4
Step – Start Time ‘Seconds’ times 4
Step – Start Time ‘Frames’ times 4
Step – Stop Time ‘Hours’ times 4
Step – Stop Time ‘Minutes’ times 4
Step – Stop Time ‘Seconds’ times 4
Step – Stop Time ‘Frames’ times 4

Note: Stop Times of 00:00:00:00, or less than the Specified Start Time are ignored. The ‘times 4’
indicates simple multiplication. For example, a Start Time of 01:10:50:00 would be input as: 4, 40, 200,
and 0 to channels 40-43.
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Appendix B – Automation API
Starting with version 1.1 of the BlueLite X1, an Automation API is included. This will allow 3rd party
developers to create applications that work in conjunction with the BlueLite X1 system.
The Automation API allows an external program do anything that can be done from the BlueLite X1’s
DMX-512 input. This includes:
•
•
•
•
•
•
•

Set Submaster Levels
Load Presets
Set the Grandmaster Level
Set XY Crossfader Levels
Play, Stop, Record
Set Transport Mode
Play a specific event list section (DMX-512 input ‘Automate’ feature)

In addition, the Automation API provides support for the following
•
•
•

Assigning Cues to either a Submaster or an XY Crossfader
‘Quietly’ loading a Show file (no prompts for changes, etc.)
Monitor X1 State (stopped, playing, recording), Mode (Internal, Timecode, Step), Current Time,
and, if applicable, Current Timecode Status

You can download and try the existing sample applications, which include a simple time/date show
scheduler, a Cue Chaser (sequencer), and MIDI input and triggering, from
www.innovateshowcontrols.com/x1automation. You can also download the API documentation, as well
as source code for the existing samples if you are interested in creating your own add-on application.
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Appendix C – LivePanel MIDI Maps
The LivePanel has three built in MIDI Maps for interpreting incoming MIDI messages. Each map is laid
out in detail below
Map 0 – Notes
This Map relies heavily on NoteOn messages, but also uses some CC (Controller Change) messages
Note On Messages
Pitch
Action
0-23
Select Page 1-24
24
Select Previous Page
25
Select Next Page
26
Chase 1 Stop
27
Chase 1 Reverse
28
Chase 1 Bally
29
Chase 1 Forward
30
Chase 1 Step
31
Chase 2 Stop
32
Chase 2 Reverse
33
Chase 2 Bally
34
Chase 2 Forward
35
Chase 2 Step
36
Chase 3 Stop
37
Chase 3 Reverse
38
Chase 3 Bally
39
Chase 3 Forward
40
Chase 3 Step
41
Chase 4 Stop
42
Chase 4 Reverse
43
Chase 4 Bally
44
Chase 4 Forward
45
Chase 4 Step
46-49
Select Active Chaser
50
Active Chaser Stop
51
Active Chaser Reverse
52
Active Chaser Bally
53
Active Chaser Forward
54
Active Chaser Step
55-58
Activate Toggles 1-4
59
‘Tap’ button (set speed for active chaser)
60-108
Recall 48 Sequences on current Page
Controller Changes
CC Number
Value
7
0-127
81
0-127
82
0-127
83
0-127
84
0-127

Description
Adjust Grand Master
Adjust Active Chaser Level
Adjust Active Chaser Speed
Adjust Chaser 1 Level
Adjust Chaser 1 Speed
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85
86
87
88
89
90
91
92

0-127
0-127
0-127
0-127
0-127
0-127
0-127
0-127

Adjust
Adjust
Adjust
Adjust
Adjust
Adjust
Adjust
Adjust

Chaser 2 Level
Chaser 2 Speed
Chaser 3 Level
Chaser 3 Speed
Chaser 4 Level
Chaser 4 Speed
Crossfader 1 (if not disabled)
Crossfader 2 (if not disabled)

Map 1 – CC Values
This map exclusively uses Controller Change (CC) Values.
Controller Changes
CC Number
Value
7
0-127
16
>64
17
0-31
32-63
64-95
96-127
18
>64
19
0-31
32-63
64-95
96-127
20
>64
21
0-31
32-63
64-95
96-127
22
>64
23
0-31
32-63
64-95
96-127
24
>64
25
0-31
32-63
64-95
96-127
26
>64
27
0-31
32-63
64-95
96-127
81
0-127
82
0-127
83
0-127
84
0-127
85
0-127

Description
Adjust Grand Master
‘Tap’ (Select Speed for Active Chaser)
Active Chaser Stop
Active Chaser Reverse
Active Chaser Bally
Active Chaser Forward
Active Chaser Step
Chaser 1 Stop
Chaser 1 Reverse
Chaser 1 Bally
Chaser 1 Forward
Chaser 1 Step
Chaser 2 Stop
Chaser 2 Reverse
Chaser 2 Bally
Chaser 2 Forward
Chaser 2 Step
Chaser 3 Stop
Chaser 3 Reverse
Chaser 3 Bally
Chaser 3 Forward
Chaser 3 Step
Chaser 4 Stop
Chaser 4 Reverse
Chaser 4 Bally
Chaser 4 Forward
Chaser 4 Step
Select Chaser 1
Select Chaser 2
Select Chaser 3
Select Chaser 4
Adjust Active Chaser Level
Adjust Active Chaser Speed
Adjust Chaser 1 Level
Adjust Chaser 1 Speed
Adjust Chaser 2 Level
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86
87
88
89
90
91
92
93
94
95-98

0-127
0-127
0-127
0-127
0-127
0-127
0-127
1-48
1-24
0-63
64-127

Adjust
Adjust
Adjust
Adjust
Adjust
Adjust
Adjust
Recall
Select
Toggle
Toggle

Chaser 2 Speed
Chaser 3 Level
Chaser 3 Speed
Chaser 4 Level
Chaser 4 Speed
Crossfader 1 (if not disabled)
Crossfader 2 (if not disabled)
Sequence on current page
Page 1-24
1-4 off
1-4 on

Map 2 – Program Changes
This map is similar to Map 1, but uses Program Changes for Page and Sequence selection and Toggle
button control
Program Change Messages
Program
Action
1-48
Recall sequence on current page
49-72
Select page 1-24
73
Toggle 1 Off
74
Toggle 1 On
75
Toggle 2 Off
76
Toggle 2 On
77
Toggle 3 Off
78
Toggle 3 On
79
Toggle 4 Off
80
Toggle 4 On
Controller Changes
CC Number
Value
7
0-127
16
>64
17
0-31
32-63
64-95
96-127
18
>64
19
0-31
32-63
64-95
96-127
20
>64
21
0-31
32-63
64-95
96-127
22
>64
23
0-31
32-63

Description
Adjust Grand Master
‘Tap’ (Select Speed for Active Chaser)
Active Chaser Stop
Active Chaser Reverse
Active Chaser Bally
Active Chaser Forward
Active Chaser Step
Chaser 1 Stop
Chaser 1 Reverse
Chaser 1 Bally
Chaser 1 Forward
Chaser 1 Step
Chaser 2 Stop
Chaser 2 Reverse
Chaser 2 Bally
Chaser 2 Forward
Chaser 2 Step
Chaser 3 Stop
Chaser 3 Reverse
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24
25

26
27

81
82
83
84
85
86
87
88
89
90
91
92

64-95
96-127
>64
0-31
32-63
64-95
96-127
>64
0-31
32-63
64-95
96-127
0-127
0-127
0-127
0-127
0-127
0-127
0-127
0-127
0-127
0-127
0-127
0-127

Chaser
Chaser
Chaser
Chaser
Chaser
Chaser
Chaser
Chaser
Select
Select
Select
Select
Adjust
Adjust
Adjust
Adjust
Adjust
Adjust
Adjust
Adjust
Adjust
Adjust
Adjust
Adjust

3 Bally
3 Forward
3 Step
4 Stop
4 Reverse
4 Bally
4 Forward
4 Step
Chaser 1
Chaser 2
Chaser 3
Chaser 4
Active Chaser Level
Active Chaser Speed
Chaser 1 Level
Chaser 1 Speed
Chaser 2 Level
Chaser 2 Speed
Chaser 3 Level
Chaser 3 Speed
Chaser 4 Level
Chaser 4 Speed
Crossfader 1 (if not disabled)
Crossfader 2 (if not disabled)
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Appendix D - Hardware Pairing
With the current X1 software, up to four hardware interfaces can be attached to the same
machine. This provides 16 universes with the X1 controller and 4 universes with the X1-mini
controller. However, the X1 software offers another mode of interface usage called ‘Hardware
Pairing’.
Hardware pairing, when enabled, outputs the same DMX data on two X1 hardware interfaces.
Only one adapter, the first one ‘enumerated’, accepts SMPTE timecode and DMX-512 input.
Both adapters send the same output to DMX Outputs 1 through 4.
At first glance this may not sound terribly useful. However, in some situations DMX data must
be distributed over a very wide area. Although numerous products exist to send DMX-512 over
longer distances and over alternate transports (ex. Ethernet), cost and complexity can be
relatively high. In comparison, products to send USB over Ethernet and optical fiber are
generally a few hundred dollars.
To enable pairing:
Step 1: Turn off the computer and attach two X1 Hardware interfaces via USB
Step 2: Turn on the X1 interfaces
Step 3: Boot the computer
Step 4: Run the X1 Application
At this point, one X1 Interface should be indicating ‘active’ on its LED, the other should just be
glowing dimly. The ‘active’ unit is the unit which will accept and source timecode and will
accept DMX-512 input. If you need to reverse the units, go back to step 1 and reverse the two
USB connections at the computer.
Step 5: Exit the X1 Application
Step 6: Select ‘Start’, ‘Run’, and “regedit” to run the Windows Registry editor
Note: Users can do serious damage to their system with the registry editor, so please use caution
when making edits and revisions below.
Step 7: Locate HKEY_LOCAL_MACHINE\SOFTWARE\BlueLite\BlueLite X1
Step 8: From the ‘Edit’ menu select ‘New’ and ‘DWORD Value’
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Step 9: Rename the new value to “HWPairing” and set its value to “1” to enable (“0” equals off)
Step 10: Run the X1 Software, both adapters should now indicate active on their LEDs
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Appendix E – Using LewLight Capture with X1
BlueLite X1 V1.2 and newer supports LewLight Capture 3.0.31 and newer. To download a demo version
of Capture go to:
http://www.capturesweden.com
To try the power of Capture combined with BlueLite X1 do the following. For best results it is
recommended to install Capture and BlueLite X1 on two separate computers connected over an Eithernet
connection. If you have a fairly new computer and a good Graphic Card (32MB minimum, but 64BM+
recommended), then you can run both programs on one single computer.
1. Launch BlueLite X1
2. Load the show file "Awards.x1"
(default location is C:\Program Files\BlueLite X1\Samples)
3. Select "Tools->Capture 3.0 (CITP) Interface" from the menu to enable Capture support
4. Launch Capture
5. Load the show file "Awards.cpf"
(default location is C:\Program Files\Capture 3.0\Projects)
6. Click on the "Universes" Tab. Right Click on Universe "A", select "Provider->Setup" and
select "BlueLite Out01"
7. Do the same for Universe "B" and "C" and assign it to "BlueLite Out02" and "BlueLite Out03"
8. In BlueLite: Open the Event List Window
("Windows->Event List" from the menu)
9. Press Play to run the show
Besides Capture 3.0 simulating the entire output of the BlueLite X1's 16 Universes, the following
additional features are supported.
When opening the Cue Editor(Select"Windows->Cue List", then double click on any cue number) any
device selection will be reflected in Capture 3.0 (Allow 15 seconds to synch after Capture is first started)
Any Fixture modification (position, shutter, color, …) in Capture will be reflected in the BlueLite X1
show as long as the Cue Editor is open and the currently edited fixture is contained in the opened cue.
This is especially useful if you select multiple fixtures in Capture, then select"Edit->Select/Focus/Patch"
from the menu and focus them with one click. All positions will be automatically updated in the Cue
Editor in the BlueLite X1. (Modifying the position in the Cue Editor in BlueLite will of course also be
reflected in Capture.)
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Appendix F – Using ArKaos VJ DMX with X1
BlueLite X1 V1.21 and newer supports ArKaos VJ DMX (V3.5 and newer) and ArKaos VJ HW directly
via the ArtNet protocol. To download a demo version of the ArKaos media software go to:
www.arkaos.net
To try the power of ArKaos VJ DMX combined with BlueLite X1 do the following. For best results it is
recommended to install ArKaos VJ and BlueLite X1 on two separate computers connected over an
Eithernet connection. If you have a fairly new computer and a good Graphic Card (32MB minimum, but
64BM+ recommended), then you can run both programs on one single computer.
1. Start ArKaos VJ
2. Select Edit -> Preferences -> DMX Setup from the ArKaos VJ menu

3.
4. Select “ArtNet” as the DMX Device
5. Select “Setup”
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6. Select “Receive only from” so it is checked
7. Make sure the Device name reads “ArKaos VJ”
8. Select your desired Sub-Net and Universe and Select OK
Important Notes: If you are running both programs on the same computer and are not connected to an
active LAN, use Sub-Net 0 and Universe 15. ArtNet universes start at 0, so this will be the equivalent of
Universe 16 on the X1.
If you are running the program connected to an active LAN, either on the same computer or a different
computer, you can set Sub-Net and Universe to any value you desire. But, again, the equivalent X1
universe will be ArtNet Universe + 1.
The selected universe does not have to have X1 hardware attached to it. That is, if you have an X1 or X1mini interface you do not have to use those universes for ArKaos.
9. Select “Use Device” so it is checked
10. Select a desired “Fixture Mode” for ArKaos and Select OK.
If you need looping, or are using ArKaos VJ HW with a compatible display adapter, use the “Full” fixture
profile. If you do not need looping and do not have access to the extra HW version features, you can use
the “Tiny” fixture profile.
11. Run the BlueLite X1 application
12. Open the Device Manager Window and insert the appropriate ArKaos VJ templates (full or tiny)
in the appropriate universe
Be sure to insert a template for each ArKaos layer. For example, if you specified 8 video layers, you will
have 8 X1 devices, one right after another.
13. Select “ArKaos (ArtNet) Interface” from the Tools menu
If ArKaos is detected via a LAN, the X1 software will connect automatically. If no LAN is present or
ArKaos is not detected, the following message box will appear:
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If you select “Yes”, the software will try searching for ArKaos via a LAN again. If you select “No”, the
software will ‘force’ ArtNet packets to be sent to the local machine. Again, note that when running this
way (no LAN, both software applications on one machine) ArKaos must be configured for Sub-Net 0 and
Universe 15 (Universe 16 on the X1).
14. Cue the X1 ArKaos Devices normally
Tip: The ArKaos VJ “DMX Keyboard Layout” screen is a good way to monitor the effects of DMX
control from the X1.
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